
3D Data Processing Software

Reference Manual



Safety Symbols
The following symbols are used in this manual to prevent accidents that may occur as a result of incorrect use of 
the instrument.

Indicates information that contains safety warnings or notes. 
Read the information carefully to ensure safe use.

Indicates a prohibited act.
Never commit such acts.

Indicates an instruction.
Adhere to the instruction.

Indicates safety information concerning the laser.
Read the information carefully to ensure safe use.

Official Names for Application Mentioned in This Manual
(Indication in this manual)	 (Official name)
Windows, Windows Vista	 Microsoft ® Windows ® Vista ® Business Operating System
Windows, Windows XP	 Microsoft ® Windows ® XP Professional Operating System
Windows, Windows 7	 Microsoft ® Windows ® 7 ® Professional Operating System

Trademarks
•	 Microsoft, Windows, Windows 7, Windows Vista and Windows XP are registered trademarks of Microsoft 

Corporation in the United States and other countries.
•	 Other product names and company names are the registered trademarks or trademarks of their respective 

owners.

Notes on This Manual
•	 It is strictly prohibited to copy or reproduce any of the content in this manual without the expressed permission 

of KONICA MINOLTA. 
•	 The contents of this manual are subject to change without notice.
•	 Every effort has been made in the preparation of this manual to ensure the accuracy of its content. However, 

should you have any questions or find any mistakes, please contact the place of purchase.
•	 KONICA MINOLTA assumes no responsibility whatsoever for accidents or other consequences arising from the 

use of this software in disregard of the content of this manual.

About This Manual and Related Documents
This manual explains RANGE VIEWER commands in the sequence they appear in the menu bar. RANGE VIEWER 
is 3D scanning software created specifically for KONICA MINOLTA RANGE7/5. 
The following manuals are related to the information contained herein.

Title Description

RANGE VIEWER User’s Guide Explains basic operation of RANGE VIEWER.

RANGE7/RANGE5
Instruction Manual

Explains the functions, operating procedures and warnings of the RANGE7/5 
that acquires 3D profile data of diverse kinds of industrial products at high 
speed and to a high degree of accuracy.

RANGE VIEWER Installation
Guide This sheet explains how to install or uninstall RANGE VIEWER.



Safety Precautions
When using RANGE VIEWER, observe the following precautions to ensure correct safe use. Also, read this 
manual carefully and keep it in a handy place for future reference.

WARNING Failure to observe the indicated information may result in serious injury or even death.

Failure to observe the indicated information may result in fire or electric shock. Before 
using this system, carefully read the manuals provided with the RANGE7/5 and computer 
together with this manual to ensure correct safe use.

Do not look directly into the laser emission window of the RANGE7/5.

Keep lenses, objects with mirror-like surfaces and optical elements out of the opti-
cal path of the RANGE7/5 laser. These objects can focus the laser beam, resulting 
in damage to eyes, fire and burns. Also, to prevent inadvertent accidents, situate 
works in front of a wall or other structure that shields the laser beam.

Package Contents
RANGE VIEWER Install CD-ROM x 1•	
Installation Guide•	

Software Restrictions
The terms and conditions for using this software are provided in the Software User’s Agreement window that ap-
pears online during installation. This software may only be installed by agreeing to those terms and conditions.

Notes on Use
This software is application software for Windows Vista, Windows XP or Windows 7. Neither the package nor •	
product includes an OS.
One of these operating systems•	  must be installed in the computer before this software may be installed.
Load the CD-ROM into the CD-ROM drive with the correct side up. Keep level and do not force into the slot.•	
Do not dirty or scratch the CD-ROM. Dirt on the recording surface and scratches in the label may cause read •	
errors.
Be careful of sharp temperature changes and condensation.•	
Keep the CD-ROM away from direct sunlight, heaters and other sources of heat.•	
Do not subject the CD-ROM to strong impacts or drop it.•	
Keep water, alcohol, thinner and other chemicals away from the CD-ROM.•	
Turn ON power to the computer to eject the CD-ROM.•	

Notes on Storage
After use, return the CD-ROM to its case and store with care.•	
Keep the CD-ROM away from direct sunlight, heaters and other sources of heat.•	
Do not store the CD-ROM in highly humid environments.•	

Every effort has been made in the preparation of this product. However, should you have any questions or find any 
mistakes, please contact the place of purchase or a customer service center.
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Introduction
RANGE VIEWER is newly developed 3D scanning software capable of controlling RANGE7/5 scanning 
and registering, merging and editing scanned data. It adopts a new GUI that enables seamless scanning 
and editing of scanned data. Moreover, it runs on  Windows 7, Windows Vista or Windows XP and can 
handle large volumes of data.
It is equipped with a navigator for showing operating methods and procedures in a large navigation window, 
making it possible for anyone from skilled engineers to beginners to easily and speedily operate.

Main Functions
Data input	 Original format: .rgv (1 shot data set) .rvm (multiple data sets),  
	 Marker information: .rmk, .txt
Data output	 ASCII, STL, original format: .rgv and .rvm, Marker information: .rmk

Scanning support	 Monitored images, preview, AF and AE, scanning and rotational stage control
Editing	 Data registration, data merging, point deletion
Drawing	 Point shading

Required Operating Environment
OS	 Windows Vista Business SP2 (64bit), 
	 Windows XP Professional x64Edition SP2 (64bit)
	 Windows 7 Professional (64bit)
CPU	 Core2Duo, Xeon or faster
RAM	 4GB or more
Display	 1280 x 1024 or higher resolution graphics
Graphic board	� OpenGL board (It is recommended to use boards tested and proven by KONICA 

MINOLTA.)
Interface	 USB 2.0 port

Installation and Uninstallation
Install and uninstall RANGE VIEWER in a computer as explained in the RANGE VIEWER Installation 
Guide.

(Added/Changed functions in Ver. 2.0)
1.	 Compatible with Windows7 Professional 64bit.
2.	 From the viewpoint of improvement in operability and data visibility, the GUI design was modified.  3D 

view of the Scanning mode screen was changed from 3 screens to 2 screens. 
3.	 [Edit marker holes] was added to the editing function.  The marker part became capable of being hole-

filled by RANGE VIEWER.
4.	 By means of the paired points initial registration, selected data can be moved not just immediately after 

scanning but at other moments.
5.	 By means of the paired points initial registration, registration can be performed based on the plural 

number of data.
6.	 Background colors and scanned data color scheme (surface, back side) of windows were changed.  

Linkage of scanned data and an un-shot part can be identified easily.
7.	 Changed the marker display color of 2D view. A marker can be displayed at the time of contour display as well.
8.	 A selection screen is zoomed in while monitoring is being executed.  A position during scanning became 

easy to confirm. 
9.	 Rotary movement of a viewing position followed by 3D view provides more intuitive mouse operation.
10.	Extensively speeded up the function to select point groups.
11.	Displays version of firmware for the scanning device in [Instrument information] dialog.  
12.	Automatically deletes groups of very small points at the time of scanning.  Editing labor can be saved. 
13.	Strengthened the data noise deletion function, and improvement was made with the data quality of edge 

part.



How to Use this Manual
This Reference Manual explains RANGE VIEWER features and functions by focusing on the commands 

selected from menus and buttons. As in the Users Guide, explanations follow the sequence of the menu bar 

to elucidate the details of setting items, etc.

The screen picture in this document is the display example of Windows 7 in use.

RANGE VIEWER Reference Manual
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2. Edit
2.1 Undo
This command cancels the last editing operation on the editing window.

 Note
Only the last operation is undone. Moreover, merging cannot be reversed.

Operating Procedure Shortcut    Ctrl+Z Edit button    

1 Click  [Undo] button or select [Undo] 
from the [Edit] menu.

The last editing operation executed on the editing 
window is reversed. Only the last operation can 
be undone.

If elements were merged, merging cannot be 
reversed.
If scanning imported another element after edit-
ing was done, the last editing operation can still 
be undone.

•

•

2.2 Redo
This command reexecutes the last editing operation on the editing window that was undone by the [Undo] 
command. 

 Note

Only the last undone operation can be reapplied.

Operating Procedure Shortcut    Ctrl+Y Edit button    

1 Click  [Redo] button or select [Redo] 
from the [Edit] menu.

The last undone operation executed on the editing 
window is reapplied. Only the last undone opera-
tion can be redone.

If scanning imported another element after edit-
ing was done, the last undone operation can still 
be reapplied.

•

2.3 Select
When you want to erase unnecessary data, such as a background shot when the measurement is done, you 
can select the section you want to erase and invert the selected section. To use these commands, the edit tab 
must be selected and at least one element must be registered.
Points can be selected using rectangles, Bezier curves, element boundaries or as all points, and reversed 
between selected/unselected. Only the points of selected elements in the element list are selected. However, 
if front point selection is ON, only points facing to the front are selected. And, both points of elements selected 
in the element list and points of unselected elements appear in the 3D view.

A. Rectangle

This command selects/unselects all points lying within rectangles drawn with the mouse.

Operating Procedure Shortcut    Shift+R Edit Button    

1 Click the  [Rectangle select] button 
or select [Select] – [Rectangle] from the 
[Edit] menu.

2 While holding down the left mouse but-
ton, drag to enclose the area you want to 
select (deselect) with a rectangle.

Rectangle is set when left mouse button is released.

3 When you click the right mouse button in-
side the area enclosed by the rectangle, a 
pop-up menu is displayed.

4 When you click the right mouse button in-
side the area enclosed by the curved line 
or at the end of drawing the curved line, a 
pop-up menu is displayed.
The selected area appears in the color set for 
[Color of selected points] on the Preferences dia-
log box.

To redraw the target area, click  [Undo] but-
ton and reselect the area.

To add more target areas, repeats steps 2  
~ 4 .
Selecting [Cancel] in the pop-up window can-
cels the drawn rectangle.

•

•

•

5 Edit the selected areas as needed.
Delete selected points.
Invert selected points between selected/un-
selected.
Unselect selected points.

•
•

•

 Supplement
All selected elements in the element list are subject to this operation.

 To Change the Color of a Selected Area

Change the color in the preferences. 
See “1.6 Preferences” on p.18.

Click mouse but-
ton at start point.

Release mouse button 
at end point.

Command available on the scan window 
(The icon is ghosted if the command is 
not available.)

Command available on the edit window 
(The icon is ghosted if the command is 
not available.)

Shortcut if available

Icon of command button 
if available

Chapter index
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RANGE VIEWER Startup
When you start RANGE VIEWER, the software will attempt to recognize the RANGE7/5. When the device is 
recognized, measurement becomes possible.Therefore, check that the RANGE7/5 is connected correctly to 
the computer before starting RANGE VIEWER.However, when only editing will be performed, it is not neces-
sary to have the RANGE7/5 connected to the computer.

Startup
Operating Procedure

1 From the Windows start menu, open 
[All Programs] – [KONICA MINOLTA] 
– [RANGE VIEWER], and select [RANGE 
VIEWER Ver.*.*].
The opening window appears for 3 sec as RANGE 
VIEWER starts up.

 Supplement
•	 Windows open at the maximum size when the 

application starts up.
•	 A warning appears if the display resolution is 

too low.
•	 You can also start directly by double clicking a 
RANGE VIEWER data file. (The splash screen 
is not displayed when you start directly from a 
file.)

2 Scanning status is shown in the status 
bar.

Status bar

	 Sensor icon

	 Sensor icon with warning mark

	 Ghosted sensor icon

•	 Whether properly connected to the instrument 
or not

•	 Scanning lens
•	 A warning appears until instrument temperature 

stabilizes.
•	 A sensor icon appears when connection has 

been achieved.
•	 A warning mark appears over the sensor icon 

until temperature stabilizes.
•	 A warning mark appears over the sensor icon 
if the temperature changes (approx. ±1.5˚C) 
from the last calibrated temperature.

•	 The sensor icon is ghosted if the instrument 
is not connected.

 Supplement
The RANGE7/5 requires time to warm-up. RANGE 
VIEWER displays a warning for a short time after 
power is turned ON based on the internal temper-
ature of the RANGE7/5.
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Exit	
Operating Procedure

1 Select [Exit] from the [File] menu.

RANGE VIEWER quits.

The message to confirm saving data will  appears, 
if there are any elements that were changed after 
scanning or the last time that data was saved.

When you click the [Yes] button, the measured •	
and edited data are saved and the RANGE 
VIEWER is exited.
When you click the [No] button, the RANGE •	
VIEWER is exited without the measured and 
edited data being saved.

  Supplement
“Element” is the 3D data unit used by RANGE 
VIEWER. Normally, one element is generated 
and edited from scanning.
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Window Configuration
Scan Window
RANGE VIEWER has a “scan window” for scanning and an “editing window” for editing. These windows can be opened 
by clicking the scan and edit tabs at the top of the window.

 Common GUI
A Title bar Displays the name of the software.
B Menu bar Contains various functions for operating RANGE VIEWER. Clicking a header 

opens a drop-down menu from which functions can be selected.
C Menu buttons Buttons for executing often-used functions of the menu bar.

Viewpoint rotate
Viewpoint move
Zoom
Zoom selected area
Fit to window
Show points
Show shaded points

D Scan tab Switches to the scanning mode for controlling the RANGE7/5 and acquiring 3D 
data. Click to switch the screen to the “Measurement Screen”.

E Edit tab Switches to the editing mode for viewing and editing acquired 3D data using 
editing tools. Click to switch the screen to the “Edit Screen”.

F Status bar Displays the connection status of the RANGE7/5 and information such as op-
eration and procedure hints.

G Navigation
message

Displays hints and messages on upcoming operations according to selected 
operations and status.

H Element list List of registered elements. Elements can be selected/unselected as well as 
shown/hidden by checkbox operation.
*The element list for the "scan window" is different from that of the "editing win-

dow", and only a single element can be selected in the "scan window" element 
list.

*Selected elements only can be displayed by selecting the elements while 
pressing the Alt key. 

B

F

E

4
5
6

3
2

1

A

C
D

H

G

7

8
9



9

Startup

  

1

2

3

4

5

6

 Error 
Messages

Menu
Items

Glossary

Index

File

Edit

View

Measure

Instrument

Help

Window
Configu-
ration

 Scan Window GUI
1 Scan settings The current settings of the scan parameters are displayed. Scan parameters 

can be changed. If the data reduction ratio setting is changed, data can be re-
ducted when they are scanned. 

2 Monitor button Clicking projects the FOV (Field Of View) indicator on the work and displays a 
2D image of the work in the monitor window.

3 AE/AF buttons Starts AE/AF, AF only or AE only based on scan settings.
4 Spot AF button When you press the point AF button and then specify the focus point on the 

monitor screen by clicking on the point you want to focus on, the RANGE7 focuses 
automatically on the specified point.

5 Preview button The object is prescanned.
6 Scan button Scans the work based on scan settings.
7 Monitor window Perform monitoring of the object by the monitor button, and display the zoomed out 

monitor screen. You can check and adjust the FOV (field of view = measurement area). 
The green vertical line indicates the center of the lens, while the black vertical line 
is for adjusting scanning distance and focus.

8 Selection screen 
(Preview screen)

Displays only the data selected from the element list. Scanned objects pre-
scanned by the preview button or the data scanned by the scanning button are 
selected and displayed in this screen. The paired points registration is done by 
the 3D image on this screen and the 3D image on the measured screen. When 
the scanned data are selected, the letters on the upper left indicate [Selection] 
and if previewed data are selected, then the display becomes [Preview].  

9 Previous window This is the window to confirm scanned data as 3D image. Shows setting of 
Display/Non-Display of the element list, and elements selected from the element 
list are shown in selected colors while the rest are in a non-selected color.  
Paired points are performed in 3D image of this screen and selected (preview) 
screen of 3D image.

Point Only one RANGE VIEWER can be running at a time.

 Displays the scanned data in a monochrome 
view.

 Displays scanned data in differing colors by 
distance.

  �Displays the color bar used to display scanned 
data in differing colors by distance.

 Deletes previews and the last scanned ele-
ment. 

Unnecessary 
markers in 
scanning with 
marker points 
are deleted 
directly from 
the monitor 
window.

Delete last data button
Show color bar checkbox
Show contours button
Show monochrome view button

Set registration points button
Color bar
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Editing Window
RANGE VIEWER has a “scan window” for scanning and an “editing window” for editing. These windows can be opened 
by clicking the scan and edit tabs at the top of the window.

 Common GUI
A Title bar Displays the name of the software.
B Menu bar Contains various functions for operating RANGE VIEWER. Clicking a header 

opens a drop-down menu from which functions can be selected.
C Menu buttons Buttons for executing often-used functions of the menu bar.

Viewpoint rotate button
Viewpoint move button
Zoom button
Zoom selected area button
Fit to window button
Show points button
Show shaded points button

D Scan tab Switches to the scanning mode for controlling the RANGE7/5 and acquiring 3D 
data. Click to switch the screen to the “Measurement Screen”.

E Edit tab Switches to the editing mode for viewing and editing acquired 3D data using 
editing tools. Click to switch the screen to the “Edit Screen”.

F Status bar Displays the connection status of the RANGE7/5 and information such as op-
eration and procedure hints.

G Navigation
message

Displays hints and messages on upcoming operations according to selected 
operations and status.

H Element list List of registered elements. Elements can be selected/unselected as well as 
shown/hidden by checkbox operation.

E
1

D

A

C
B

G 2

H

3
F
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Point This window is for editing scanned data. Preview data cannot be edited. Also, reference markers 
are not shown.

 Editing Window GUI
1 Editing tool buttons For editing 3D images. The selected button is highlighted.

Rectangle select
Draws a rectangular area for selecting/unselecting points.

Bezier select
Draws a Bezier curve for selecting/unselecting points.

Point selection invert
Inverts points between selected/unselected.

Element boundary point select
Selects only boundary points of elements.

Front facing points
Enables selecting points having the normal facing towards the camera

Point delete
Deletes the selected points.

Undo
This cancels the last edit operation and returns the software to the 
state just before that operation.

Redo
This redoes the edit operation canceled with the “Undo” button. 

Element registration
Registers the selected elements.

Edit marker holes
Edit data of the market part.

Element merge
Merges the selected elements.

Open
Opens files.

Save
Saves files.

Export
Exports elements to other applications.

2 3D view Displays a 3D view of works as they are edited.
3 Element delete button To delete an element, select the element to delete from the element list and 

then click the [Delete Element] button. Multiple elements may be selected at a 
time.
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1.	File
1.1	 New
When selected, the currently open file is discarded and a new file is created in rvm format. If opened files need 
to be saved, save them before selecting [New].

Operating Procedure Shortcut    Ctrl+N –

1  Select [New] from the [File] menu.

The currently open file closes and a new file is 
created.

 Supplement
Files can be created in rvm and rgv formats. See below.

File Formats
RANGE VIEWER uses two file formats: rvm that groups all elements into a single file and rgv that cre-
ates one file for each element.

rvm format
Multiple elements are grouped into a single file.

rgv format
Each element has its own file.

rgv

rgv

rgv
rvm
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1.2	 Open
This command opens files. You can select whether to open rvm or rgv files.

Operating Procedure Shortcut    Ctrl+O Edit Button    

1 Select [Open] from the [File] menu.

The Open File dialog box appears. Files can be 
opened from the editing window by clicking  
[Open] button. 

2 This specifies the file type.

Files of the selected format appear.
 Supplement

rvm:	The currently opened file is discarded and 
a new file is opened. To keep the currently 
opened file, save the file and then select 
"Open". 

rgv:	Elements are added to the currently open 
file. 

3 Select a file and click [Open] button. 

When having selected rvm file, only one file can 
be opened at a time.

 Supplement
Only files of rvm or rgv format can be opened. For details on the file format, see the column on the bottom row of 
Page 12.
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Cautions for saving data by different file formats.
rvm format files can be saved with [Save] button, but “•	 rgv” files can not.
Even when saving an “rgv” file with its current name, you must use [Save As].•	
The path for saving a new file is the default file path set in the environmental settings (•	 Page 20).
When you save a file in rgv format, the file name becomes Input file name + “- (Hyphen)” + Element Name + •	
“.rgv” (extension).  As many files will be created as the number of the elements.

1.3	 Save
When you select [Save], the file that is currently open and being worked on is saved with its current name, 

overwriting the older version of the file. Only rvm file format can be saved.

Operating Procedure Shortcut    Ctrl+S Edit Button    

1 Select [Save] from the [File] menu.

If the file has been newly created, the Save As 
dialog box appears. 
If an existing file has been edited, the file is over-
written and saved. 
Files can be saved from the editing window by 
clicking  [Save] button. 

 Supplement
For details on the file format, 1.	 see the column on the bottom row of Page 12.
You can set automatic save as described in •	 “1.6 Preferences” on Page 18.
Only rvm files can be overwritten and saved.•	
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1.4	 Save As
Selecting [Save As] allows you to rename open files and save them under different names.

Operating Procedure Shortcut    – –

1 Select [Save As] from the [File] menu.

The Save As dialog box appears.

2 Select a file format and input a file name.

File names must conform to Windows restric-
tions.

3 Click the [Save] button.

The file is saved in the selected format.

 Supplement
For both rvm files and rgv files, you can save with the current name by selecting [Save As]. 
For details on the file format, see the column on the bottom row of Page 12.
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STL Files
This file format is specifically for SLA CAD software by 3D Systems. 
It is supported by a wide range of analysis software and allows 3D data to be directly input in STL format for use 
with prototyping machines. The recorded 3D modeling data forms a polygon of the surface normal vectors and 
coordinates for three vertexes of a triangle. STL files can be ASCII or binary format, but RANGE VIEWER exports 
only the binary format.
Merged data is exported to a single STL file without connections between the merged elements.

ASC Files
Exported ASC (ASCII) files contain 3D point data without normal (Normal line) information.

1.5	 Export
Scanning data and editing data can be exported to other 3D point processing software from other manufacturers. 
Data can be exported for use with other programs either by saving the 3D data in a file or by directly exporting 
the 3D data to external software using IPC function.

A.	 Exporting Files

 Memo
The method of exporting to a file is generally called “Exporting”.
This converts from the unique formats (rvm and rgv) used as the standard with this software into other file formats and 
saves the file in that format.

Operating Procedure Shortcut    – –

1 Select [Export] – [To File] from the [File] 
menu.
The Save As dialog box appears.

2 Select a file format for export and input a 
file name.
Data can be exported in STL or ASC format. 

3 Click the [Save] button.

The file is saved in the selected (STL or ASC) format.

 Supplement
For details on STL (binary) and ASC formats, see below. 
To read rgv files on other 3D point processing software, select [File] - [Export] and save the file in rgv format. See 
“When Saving rvm and rgv Files” on p. 14.
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B.	 Exporting Directing to Other Software with the IPC function

 Memo
The method of directly exporting to external software is generally called “File Transfer”.•	

 Note
When exporting directly to external software, it is necessary to first start the external software that will receive the •	
export and prepare it to be able to import.
For details on how to prepare the external software for import operation, see the user’s manual for the external soft-•	
ware.

Operating Procedure Shortcut    Ctrl+E Edit Button    

1 Check that the external software that will 
receive the export has started and that it is 
ready to import.

2 Select [Export] – [To Application] from the 
[File]  menu.
Files can be exported from the editing window by 
clicking  [export] button. 

“*	 Application” sub menu of Export will be acti-
vated when the third-party software is ready 
to import the 3D data from RANGE VIEWER. 
At this time, “Application” menu name will be 
changed to the name that set by the third-par-
ty software.

3 Click  [Export] button. 

The file is sent to the connected software. The 
transfer is monitored by the progress bar. The time 
required to transfer the file varies according to the 
amount of data and number of scanned points.

 Supplement
To connect to external software, it is necessary 
that the external software recognizes RANGE 
VIEWER beforehand.

 Note
The sent scanned data is deleted.

Exporting with the IPC function
Exporting with [File] – [Export] – [Application Software *] uses the IPC function.
Compared to exporting through a file (Export), the file transfer export method is simpler and faster because it 
eliminates the need to save the file or read in the file.
Confirm that the external software supports the IPC function.

* “Application Software” is enabled when preparations are complete on the external software side for receiving the 
export from RANGE VIEWER, and shows the name set by the external software.

(File Transfer)
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1.6	 Preferences
The preferences allow you to set 3D image viewing, file saving operations and more.

Operating Procedure Shortcut   Shift+F1 –

1 Select [Preferences] from the [File] menu.

The Preferences dialog box appears.

2 To set display settings, click the [Display] 
tab. To set file settings, click the [File] tab.

3 After making settings, click the [OK] but-
ton.
Preferences are immediately applied. To default 
the settings, click the [Default] button.

Shading color of selected elements

Shading color of unselected elements

About parameters in [Preferences Dialog Box]

[DISPLAY] tab
Element display reduction ratio	 Only while the viewpoint is rotating or moving, the display ratio is reduced.  

Sets the display ratio of points to elements for element views. Make a selection 
from the drop-down list. 

		  Selectable ratios: 1/1, 1/4, 1/9, 1/16

		  Note: Only the display ratio is reduced; points of the original element are not 
deleted.

		  	  	  	    
		  1/1	 1/4	 1/9	 1/16
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Shading color of selected elements	 Sets the shading color of selected elements and all elements of the scan tab. 
Clicking the button of the currently selected color opens the Color Setting dia-
log box where colors can be freely selected.

		          

	  Auto	  When a checkmark is placed in the checkbox, the color select button is hid-
den and shading colors for selected elements are automatically set.

Shading color of unselected elements	 Sets the shading color of unselected elements. The currently selected color 
appears in the button. Clicking the button opens the Color Setting dialog box 
where colors can be freely selected.

Size of shaded points 	 Sets the size of shaded points. Setting range: 1 ~ 10

Color of selected points	 Sets the color of selected points. The currently selected color appears in the 
button. Clicking the button opens the Color Setting dialog box where colors 
can be freely selected.

Color of unselected points	 Sets the color of unselected points. The currently selected color appears in the 
button. Clicking the button opens the Color Setting dialog box where colors 
can be freely selected.

Size of points (1 - 10)	 Sets the size of points. Setting range: 1 ~ 10

Background color of 3D view	 Sets the background color of 3D views. The currently selected color appears in 
the button. Clicking the button opens the Color Setting dialog box where colors 
can be freely selected.

 Display title of 3D view	  Sets whether to show/hide the title of the 3D view. The title appears in the 
3D view when a checkmark is placed in the checkbox.

 Display axis	  Sets whether to show/hide the 3D coordinate axes. The axes appear in the 
3D view when a checkmark is placed in the checkbox.

OK button	 When you click the [OK] button, the contents set in the [Environmental Set-
tings] dialog are applied and the dialog is closed.

Cancel button	 When you click the [Cancel] button, the changes made in the [Environmental 
Settings] dialog are discarded and the dialog is closed.

Default button 	 Returns the settings to the default values.
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[FILE] tab

Default file path	 This displays the default file path. The file path displayed here is the default file 
path for the dialog for opening/saving a file. If Preferences ends with the default 
file path being empty, the folder that was previously opened will open when the 
file is saved, exported or opened.

	 Browse button	 For browsing file paths. When clicked, the Browse Folder dialog box appears 
whereby enabling you to select the default file path. The selected path appears 
in the [Default file path] box.

		

  

 

 Auto Save	  Data is saved at the input time interval when a checkmark is placed in the 
checkbox. Automatic saves are executed only if an element is changed. Files 
are saved in the rvm format.

	 Intervals (1 – 60)	 Sets the time interval at which data is automatically saved.
		  Setting range: 1 ~ 60 min.

OK button	 When you click the [OK] button, the contents set in the [Environmental Set-
tings] dialog are applied and the dialog is closed.

Cancel button	 When you click the [Cancel] button, the changes made in the [Environmental 
Settings] dialog are discarded and the dialog is closed.

[DISPLAY] tab		  [FILE] tab
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1.7	 Exit
This command quits RANGE VIEWER.

Operating Procedure Shortcut    – –

1 Select [Exit] from the [File] menu.

RANGE VIEWER quits.

The message to confirm saving data will appears, 
if there are any elements that were changed after 
scanning or the last time that data was saved.

When you click the [Yes] button, the measured •	
and edited data are saved and the message is 
closed.
When you click the [No] button, the message •	
is closed without the measured and edited data 
being saved.
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2.	Edit
2.1	 Undo
This command cancels the last editing operation on the editing window.

 Note
Only the last operation is undone. Moreover, merging cannot be reversed.

Operating Procedure Shortcut    Ctrl+Z Edit button    

1 Click  [Undo] button or select [Undo] 
from the [Edit] menu.
The last editing operation executed on the editing 
window is reversed. Only the last operation can 
be undone.

If elements were merged, merging cannot be •	
reversed.
If scanning imported another element after edit-•	
ing was done, the last editing operation can still 
be undone.

2.2	 Redo
This command reexecutes the last editing operation on the editing window that was undone by the [Undo] 
command. 

 Note
Only the last undone operation can be reapplied.

Operating Procedure Shortcut    Ctrl+Y Edit button    

1 Click  [Redo] button or select [Redo] 
from the [Edit] menu.
The last undone operation executed on the editing 
window is reapplied. Only the last undone opera-
tion can be redone.

If scanning imported another element after edit-•	
ing was done, the last undone operation can still 
be reapplied.
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2.3	 Select
When you want to erase unnecessary data, such as a background shot when the measurement is done, you 
can select the section you want to erase and invert the selected section. To use these commands, the edit tab 
must be selected and at least one element must be registered.
Points can be selected using rectangles, Bezier curves, element boundaries or as all points, and reversed 
between selected/unselected. Only the points of selected elements in the element list are selected. However, 
if front point selection is ON, only points facing to the front are selected. And, both points of elements selected 
in the element list and points of unselected elements appear in the 3D view.

A.	 Rectangle
This command selects/unselects all points lying within rectangles drawn with the mouse.

Operating Procedure Shortcut    Shift+R Edit Button    

1 Click the  [Rectangle select] button 
or select [Select] – [Rectangle] from the 
[Edit] menu.

2 While holding down the left mouse but-
ton, drag to enclose the area you want to 
select (deselect) with a rectangle.

Rectangle is set when left mouse button is released.

3 When you click the right mouse button in-
side the area enclosed by the rectangle, a 
pop-up menu is displayed.

4 When you click the right mouse button in-
side the area enclosed by the curved line 
or at the end of drawing the curved line, a 
pop-up menu is displayed.
The selected area appears in the color set for 
[Color of selected points] on the Preferences dia-
log box.

To redraw the target area, click •	  [Undo] but-
ton and reselect the area.
To add more target areas, repeats steps •	 2  
~ 4 .
Selecting [Cancel] in the pop-up window can-•	
cels the drawn rectangle.

5 Edit the selected areas as needed.
Delete selected points.•	
Invert selected points between selected/un-•	
selected.
Unselect selected points.•	

 Supplement
All selected elements in the element list are subject to this operation.

 To Change the Color of a Selected Area
Change the color in the preferences. 
See “1.6 Preferences” on p.18.

Click mouse but-
ton at start point.

Release mouse button 
at end point.
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B.	 Bezier
This command selects/unselects all points lying within Bezier curves drawn with the mouse.

Operating Procedure Shortcut    Shift+B Edit Button    

1 Click the  [Bezier curve select] button 
or select [Select] – [Bezier] from the [Edit] 
menu.

2 While holding down the left mouse button, 
draw a line to enclose the area you want to 
select (deselect) with a curved line.
For instructions on enclosing areas in Bezier 
curves, see “Bezier Curves” on the next page.

3 When you click the right mouse button inside the 
area enclosed by the curved line or at the end of 
drawing the curved line, a pop-up menu is dis-
played.

4 Select [Close] from the pop-up menu to 
close the encompassed area.

5 Select [Select] ([Unselect]) from the pop-
up menu to include (exclude) the selected 
area.

To redraw the target area, click •	  [Undo] but-
ton and reselect the area.
To add more target areas, repeats steps •	 2  
~ 5 .
Selecting [Cancel] in the pop-up window can-•	
cels the drawn curve.

6 Edit the selected areas as needed.
Delete selected points.•	
Invert selected points between selected/un-•	
selected.
Unselect selected points.•	

 To Change the Color of a Selected Area
Change the color in the preferences.
See “1.6 Preferences” on p.18.

 Supplement
All selected elements in the element list are subject to this operation.
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Bezier Curves
Left-clicking the mouse creates control points.

Holding and pressing the left mouse button and dragging the 
pointer creates a continuous line from the last control point.

Targeted areas are drawn by a combination of control points and 
continuous lines from them. 
Repeat these operations to enclose the targeted areas in a Bezi-
er curve.

 Note
•	 You cannot undo the last operation when drawing a Bezier 

curve.

Lastly, as stated in the procedure of the previous page, right-
click the mouse to open the pop-up menu and, select [Close] to 
close the drawn area.
•	 Selecting [Cancel] in the pop-up window cancels the draw 

curve.
•	 Pressing the [ESC] key on the computer cancels the Bezier 

curve mode.

Fine-Adjusting Bezier Curves
After a Bezier curve has been closed, the curve can be moved 
by placing the center of the + pointer on the yellow points of the 
Bezier curve, pressing and holding the left mouse button and 
dragging the pointer. Release the left mouse button when the 
point is at the desired position.

The length of the continuous line represents the amount of pull-
ing force, therefore that force can be increased or decreased. 
This changes the curvature of the line.
As when moving curves, the curve can be reshaped by placing 
the center of the + pointer on the yellow point at the end of a con-
tinuous line on the curve, pressing and holding the left mouse 
button and dragging the pointer. Release the left mouse button 
when the point is at the desired position.

 Supplement
You cannot undo to return to the previous point during 
outlining of a selection area with a Bézier curve. When 
the area has been outlined to some extent, it is more ef-
ficient to continue outlining as is and after the outline is 
completed, revise with the method above.

Drag  
yellow point.

Drag  
yellow point.

Drag  
yellow point.

Drag  
yellow point.

Drag to form line.

Continuous line  
from control point

Control point
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C.	 Point Selection Invert
Inverts the selected / unselected status of the selected element points.

Operating Procedure Shortcut    Ctrl+R Edit Button    

1 Select points using either a rectangle or 
Bezier curve, and click  [Point selec-
tion invert] button or select [Select] – [In-
vert] from the [Edit] menu.

2 Invert points between selected and un-
selected.
When there is no element selected partially with 
the rectangle or Bézier curve, the points in all el-
ements selected in the element list are inverted 
between selected and unselected.

3 Click  [Point selection invert] button to 
invert the area back.

4 Edit the selected areas as needed.
Delete selected points.•	
Invert selected points between selected/un-•	
selected.
Unselect selected points.•	

 To Change the Color of a Selected Area
Change the color in the preferences.
See “1.6 Preferences” on p.18.

 Supplement
All selected elements in the element list are subject to this operation.
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D.	 Element Boundary Point Select
This button automatically selects boundary points (circumference of holes) of elements. With merged ele-
ments, the boundary points of all merged elements are selected.

Operating Procedure Shortcut    Shift+E Edit Button    

1 Select the desired elements and click 
 [Element boundary point select] 

button or select [Select] – [Boundary]  
from the [Edit] menu.

2 Select boundary points of the element.

Of all the points that compose the element, only 
the boundary points are selected.

3 Edit the selected areas as needed.
Delete selected points.•	
Invert selected points between selected/un-•	
selected.
Unselect selected points.•	

 Supplement
All selected elements in the element list are subject to this operation.



RANGE VIEWER Reference Manual

28

E.	 Front Facing Points
This button automatically selects only the points that compose polygons in the current view of the selected 
elements (rectangle or Bezier curve used) that are facing front and visible.

Operating Procedure Shortcut    Shift+F Edit Button    

1 Click  [Front facing points] button to 
highlight it or select [Select] – [Front fac-
ing points] from the [Edit] menu.

Front facing points se-
lection is ON when the 
front point select button 
is highlighted.

2 Select the desired areas using a rectan-
gle or Bezier curve, while the front point 
select button is highlighted.

Only the points facing front in the current view of 
the elements in the selected areas are selected.

3 Edit the selected areas as needed.

Delete selected points.•	
Invert selected points between selected/un-•	
selected.
Unselect selected points.•	

(Example: When deleting by Points, only
surfaces with holes facing the front are deleted.)

 Supplement
All selected elements in the element list are subject to this operation.
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F.	 All Elements/Unselect All Elements
These commands select and unselect all elements, respectively. The commands apply only to elements, 
therefore point selection does not change.

Operating Procedure Shortcut  Alt+A/ Shift+Alt+A –

1 Select [Select] – [Select all Elements] from 
the [Edit] menu.
To unselect all elements, select [Unselect all  
Elements].

2 All elements in the element list are select-
ed and displayed in the [Shading color of 
selected elements] set in the Preference 
dialog box.

Selected points remain the color set for selected 
points.

 Supplement
All selected elements in the element list are subject to this operation.
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G.	 Selct All Points on Selected Elements/ Unselect All Points on Selected Elements
These commands select and unselect all points of selected elements, respectively.

Operating Procedure Shortcut  Ctrl+A/ Ctrl+Shift+A Edit Button    

1 Select the desired elements and select  
[Select] – [Select all points on selected 
elements] from the [Edit] menu.

To unselect all points of the selected elements, 
select [Unselect all points on selected elements].

2 All points of the selected elements are 
selected and displayed in the [Color of  
selected points] set in the Preference dia-
log box.

With [Unselect all points on selected elements], 
all points are unselected and displayed in the  
[Shading color of selected elements] set in the 
Preference dialog box.

 Supplement
All selected elements in the element list are subject to this operation.



31

Startup

  

1

2

3

4

5

6

 Error 
Messages

Menu
Items

Glossary

Index

File

Edit

View

Measure

Instrument

Help 

Window
Configu-
ration

2.4	 Delete
A.	 Deleting Selected Points
This command deletes selected points of elements.

Operating Procedure Shortcut    – Edit Button    

1 Select an area of elements and click 
[Delete] button or select [Delete] – [Points] 
from the [Edit] menu.

2 The selected points are deleted.

To restore the deleted points, click  [Undo] but-
ton.

B.	 Deleting Selected Elements
This command deletes elements selected in the element list.

Operating Procedure Shortcut    – Edit Button    

1 Select the desired elements from the ele-
ment list.

Selected elements

Element delete button

2 Click  [Element delete] button 
or select [Delete] – [Elements] from the 
[Edit] menu.

To restore the deleted elements, click  [Undo] 
button. 

 Supplement
All selected elements in the element list are subject to this operation.
Before dealing with of operation in, alert warning message is
displayed.
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2.5	 Registration
This function should be used for more precise registration of elements for which initial registration has already 
been completed. This command is for positioning two or more elements in the element list. When executed, 
the selected element of the highest position serves as the reference for positioning the other elements. A 
dialog box appears with the results.

Operating Procedure Shortcut    Alt+Shift+R Edit Button    

1 Select the desired elements from the ele-
ment list.

Selected elements

2 Click  [Element registration] button 
or select [Registration] from the [Edit] 
menu.

Registration calculations begin. Once ended, a 
dialog box appears with the calculated Mean Er-
ror and Standard Deviation.

To continue registration, click [Repeat]. Calcula-•	
tions start again.
Selecting [Quit] ends the registration.•	

To cancel registration elements, click  [Undo] 
button. 

 Supplement
Recalculate the mean error and standard deviation until the values no longer change. 

Mean Error and Standard Deviation
The mean error and standard deviation are reference values for registration results. 
Both are indicated in units of mm: mean error giving the average amount of error in the registration result 
and the standard deviation giving the variance of that error. Normally, as the values approach “0”, the 
closer the position matches the reference position. 

Registration with marker information
If there are markers, registration can be performed with the 
marker information.
If registration is performed, the dialog at right is displayed. To 
perform registration with the marker information, select [Yes]. 
If registration is performed with the marker information, each 
position is adjusted finely so that the shapes of the other parts 
will match while matching of the marker positions is maintained. 
Positions can be adjusted finely after [Initial registration] is 
performed with markers.
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2.6	 Edit marker holes
When registration is performed by using a marker, editing is done for data around the marker which is pasted 
to the scanned object. In case scanned data (rvm, rgv file) and a reference marker (rmk file) are read out, 
editing can be done for data around the marker in the same way.
The function to keep points on the marker selected (selection of points on the marker) and the function to 
replace point groups around the marker with the shape calculated based on point groups around the marker 
can be executed. 

Operating Procedure Shortcut    Alt+Shift+K Edit Button    

1 Selects elements which need to be edited 
on the element list.

Selected elements

2  Click the  [Edit marker holes] button.

Or select [Edit marker holes] on the [Edit] 
menu.

3 Select functions to be executed. 
By clicking [OK], the selected function is •	
executed. 
By clicking [Cancel], the dialog is closed without •	
executing the selected function.

[Edit marker holes] dialogue

[Selection of points on markers] 
Select all the points near the reference marker in the form of a discus. By 
deleting in the [Edit Mode] screen, a hole is formed.

 Supplement
After executing selection of points on the marker, points which were 
selected before the execution become non-selected. Only the points on 
the marker are selected. This operation can return the condition to the 
original state by cancelling.

[Marker hole-filling]
Replace points on the reference marker with the shape calculated based 
on the point around the reference marker. By means of [Hole-filling level], 
the acceptance level of a hole-filling result can be set. By increasing the 
number, markers pasted to a round surface can be hole-filled.

 Supplement
When the number of selected elements around a reference marker is 
few, the points around the reference marker are selected. Selected points 
before the execution are not selected, and only the points which failed to 
perform hole-filling are selected. This operation can return to the original 
state by cancelling.
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2.7	 Merge
This command merges two or more registered elements from the element list. When executed, unless saved 
under another name, the original elements are deleted and only the resulting merged element remains. 

 Note
Element combination cannot be undone with the [Undo] button.

Operating Procedure Shortcut    Alt+Shift+M Edit Button    

1 Select the desired elements from the ele-
ment list.

Selected elements

2 Click  [Merge] button or select [Merge] 
from the [Edit] menu.

A confirmation message appears asking whether 
to save the data or not.

3 Select whether to save the original data 
or not, before merging the elements.

If [Yes] is selected, the Save As dialog box ap-
pears for you to save the current scanned data. 
After inputting a file name and clicking the [Save] 
button, the data is saved before the elements are 
merged.
Selecting [No] merges the elements without sav-
ing their original data.
Selecting [Cancel] cancels merge processing.

4 When the merge command is executed, a 
confirmation message appears.

Selecting [OK] merges the elements. •	
Selecting [Cancel] cancels merge processing.•	

5 The merged elements are deleted from 
the element list and appear as a single 
merged element.
The file name is “Merged-x” (x being an integer 
from 0 up).
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3.	View
3.1	 Viewpoint
Change the viewpoint direction of the 3D data by selecting the command from the mouse right-click pop-up 
menu or from the menu bar. 

Operating Procedure Shortcut    Ctrl+1~6 –

1 Click the right mouse button to open 
a pop-up menu of commands and se-
lect [Viewpoint] - [Front], [Back], [Top],  
[Bottom], [Right] or [Left], or select  
[Viewpoint] and select a viewpoint from 
the [View] menu.

3D data are displayed from the direction select-
ed.

3D Orthogonal Coordinates
The position of a point in a 3D space is represented by 
coordinates in a 3D orthogonal coordinate system. The 
coordinate system here uses a point near to the center 
of the RANGE7/5’s receiver lens. The Z direction ex-
tends from directly behind the light receptor along
the optical axis to the front, the Y direction is above the 
receiver and the X direction is to the right.
* In the output 3D data, specific offsets are applied re-

spectively along the XYZ axes. 

Viewpoint
RANGE VIEWER lets you view elements from the front, back, top, bottom, right or left, or in most any orthogonal 
projection.

Y direction

＋Y

＋X

X direction

Z direction＋Z 

Back
TOP

Front

Bottom

RightLeft

XZ

Y
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3.2	 Rotate/ Zoom
The viewpoint can be rotated, moved, zoomed in/out and matched to the display size. Selected areas can be 
zoomed in/out, as well. The commands can be executed from menu buttons or the menu bar. You can also 
perform this operation from the pop-up menu displayed by clicking the right mouse button menu.

Operating Procedure Shortcut   F9~F12, Ctrl+F Edit Button 

1 Click a  menu button 
or select [Rotate/Zoom] – [Rotate], [Pan], 
[Zoom], [Area Zoom] or [Fit to window] 
from the [View] menu.
The selected command is activated.
See the following for command details.

Menu Button Functions

 
Viewpoint rotate
The viewpoint can be rotated by pressing and 
holding the left mouse button and dragging the 
mouse.
Left-clicking on a point above the scan data while 
holding down the [Ctrl] key will switch the center of 
rotation to the position of the point. 

The viewpoint can be moved by pressing and hold-
ing the center mouse button (wheel) and dragging 
the mouse. While the button is depressed, the cur-
sor appears as .

The viewpoint can be zoomed in/out by spinning 
the mouse wheel.
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Viewpoint move
The viewpoint can be moved by pressing and hold-
ing the left mouse button and dragging the mouse 
to move the cursor up and down on the screen.

 
Zoom
You can zoom in/zoom out the display range by 
pressing and holding the left mouse button, and 
dragging the pointer up/down in the screen.

  
Zoom selected area
A rectangle target area appears over the view 
while pressing and holding the left mouse button. 
The mouse can be dragged to enlarge/reduce the 
area.

When the left mouse button is released, the rect-
angle area is set.

Clicking the right mouse button opens a pop-up 
menu with [Zoom In], [Zoom Out] and [Cancel] 
commands. Operations are executed by selecting 
those commands.

  
Fit to window
Clicking the button automatically zooms the image 
so that all elements appear in the view.
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3.3	 Display Mode
3D data views can be switched between shaded images and images made up of points. 
The commands can be executed from menu buttons, You can also perform this operation from the pop-up 
menu displayed by clicking the right mouse button menu.

Operating Procedure Shortcut    Ctrl+Space Edit Button    

1 Click either  [Show points] button or 
 [Show shaded points] button, or se-

lect [Display mode] – [Points] or [Shad-
ing] from the [View] menu.
The 3D data view appears in the selected display 
mode.

Points and Shades Display Modes

  
Show points
Displays 3D data as a set of points.
The points image does not calculate the 3D shad-
ing used in shaded images, therefore it can be 
drawn more quickly than shaded views. Process-
ing goes faster with the points image when deleting 
unnecessary points and other editing operations.
The size of the points can also be set from 1 to 10. 
See “1.6 Preferences” on p. 18.

 
Show shaded points
Displays 3D data with shading. A sense of volume 
is created by calculating shadows from the loca-
tion of the light source and reflected light.
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3.4	 Element Information
Element information is recorded in scanned data. To make it easier to view and edit this information, elements 
can be selected from the element list and commands executed from the menu bar or a pop-up menu opened 
by right-clicking the mouse.

Operating Procedure Shortcut    Alt+I –

1a Select an element from the element list, 
right-click the mouse to open the pop-up 
menu and select [Element information].
The Element Information dialog box appears.

1b Select [Element information] from the 
[View] menu.
The Element Information dialog box appears.

Select an element from the [Element 
name] combo box.

 

2 Set element information, color when se-
lected and whether to show or hide the 
element.
In the [Measurement Environment], the contents 
recorded during measurement are displayed.
[Number of points] indicates the number of points 
that compose the 3D data.
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Element Information Dialog Box

Element name	 Displays the element name. Element information differs according to the ele-
ment selected in the combo box. The name in the combo box may also be 
changed.

Scan environment	 Displays parameters used in element scanning.

	 Date	 The date of measurement of the selected element is displayed.

	 Scanning instrument type 	 Displays the type of the instrument used to scan this element.

	 Instrument serial number	 The serial number of the measurement device used to measure the element is 
displayed.

	 Lens type	 Displays “TELE/WIDE” as the type of lens used to scan the element. “---” ap-
pears with merged elements if different types of lenses were used to scan the 
individual elements.

	 Ambient temperature (deg.)	 Displays the temperature of the instrument at the time the element was 
scanned.

	 Number of scans	 Displays the number of times the selected element was scanned. “+1” is dis-
played if the element was created through a Dark Surface mode.

	 Data reduction ratio	 Select a data reduction ratio from [1/1], [1/4], [1/9] and [1/16]. Since the number 
of data in the original element is deleted for scanning, the data reduction ratio 
of the scanned data cannot be changed.

	 Scan distance (mm)	 Displays the distance from the selected element in scanning.

	 Laser power	 Displays the exposure level used in element scanning.

	 Temperature at calibration (deg.)	 Displays the instrument temperature after calibration.

	 Calibration time	 Displays the date and time that the instrument was calibrated.

Number of points	 Displays the effective number of points of the element.

Color of selected element	 Displays the color used when the element is selected. Although the shading 
color of selected elements is set in the Preferences dialog box, this shading 
color can be individually set for each element. The color in the element list is 
that selected here.

		

		  Clicking the color button opens the [Color]  dialog box where colors can be 
freely selected.

        

Display status of element	  Displays whether the element is shown or hidden. The setting can be 
changed. This item is linked to the checkbox in the element list.

3D image	 Displays the 3D image of the element in two dimensions. The XY points are the 
horizontal and vertical edges of the image, while the Z coordinate is displayed 
on a grey scale. “Merged” is displayed for merged elements.
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4.	Measure
WARNING
Do not look directly into the laser emission window.
Keep lenses, objects with mirror-like surfaces and optical elements out of the optical path. 
These objects can focus the laser beam, resulting in damage to eyes, fire and burns. Also, to 
prevent inadvertent accidents, situate works in front of a wall or other structure that shields 
the laser beam.

4.1	 Monitor
This command monitors the work and displays it in the monitor window so that you can position the scanning 
area. A vertical green line representing the center of the lens to aid positioning, and a vertical black line to help 
you adjust the stand-off distance and focus will appear.

Operating Procedure Shortcut    F2 Monitor Button    

1  Click  [Monitor] button or select  
[Monitor] from the [Measure] menu.
The image obtained from monitoring appears in 
the monitor window.

While watching this image, you can adjust the lo-
cation and posture of the work and RANGE7/5 so 
that the targeted scan areas fits inside the monitor 
window and straddles the green vertical line mark-
ing the lens center at the center of the window.

Monitor button

 Supplement
Monitoring automatically ends 10 min after being started.•	
If another button is clicked while monitoring is in progress, monitoring ends and the software transitions to the process-•	
ing of the clicked button.
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FOV Indicator
A FOV (field of view) indicator projects the pattern 
of light shown at right on the work to make it easier 
to identify the scan area. 
The FOV indicator is synchronized with motor 
operation to continuously project the light. (Note: 
FOV indicator updates slow while RANGE VIEW-
ER windows are being operated.)

Multi focus
In the Multi focus mode, scanning is performed 
twice by changing the focal point.
When the Multi focus mode is active, the data of 
the area closer to the focal point is selected for cal-
culation. Depending on the work, the effects may 
differ. However, when you want to obtain results 
with less data noise, set Multi focus to "Enable". 
Compared to when Multi focus is set to "Disable", 
it takes more time to display the results.

Multi focus is enabled and disabled from the Scan 
settings dialog box. See “4.6 Scan settings” on p. 
67.

Scan Position Adjustment
The location and posture of the work and RANGE7/5 
can be adjusted so that the two are appropriately po-
sitioned for scanning. These adjustments are made 
by activating the monitoring feature and watching the 
work in the monitor window.

Distance to work and work size                     (Unit: mm)

Lens TELE lens WIDE lens

Distance 450 800 450 800

X × Y 79 × 99 141 × 176 150 × 188 267 × 334

Z 54 97 109 194

Memo   For RANGE5, please refer to the WIDE lens data.

Distance to work and work size 
in Multi focus mode                                        (Unit: mm)

Lens TELE lens WIDE lens

Distance 462 781 475 766

X × Y 81 × 102 138 × 172 159 × 199 256 × 320

Z 54 97 109 194

Memo   For RANGE5, please refer to the WIDE lens data.

Distance to work
450mm~800mm

Light-receiving
lens 

Y

X Z

RANGE7/5

Work

RANGE7: TELE/WIDE replaceable
RANGE5: Lens not replaceable(                  )

The estimated scan area 
is irradiated in synch with 
motor operation.

                      Z                                                 Z                     
Scan area                                        First  

Second
                                  

   

Multi focus disabled                           Multi focus enabled

Multi focus image 

The origin is set at the sensor position ••
which is approximately 120 mm behind 
the center of the lens surface. There-
fore, the Z dimension has an offset of 
around 120 mm applied. 
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4.2	 AE/AF
Automatic exposure (AE) and automatic focusing (AF) are available to accurately scan works. To use AE/AF 
and spot AF, it is necessary to select [AF only], [AE only] or [AE/AF] under [AE/AF configuration] on the Scan 
settings dialog box. See “4.6 Scan settings” on p. 67.

AE/AF

Operating Procedure Shortcut    F3 AE/AF Button    

1 Click  [AE/AF] button or select  
[AE/AF] from the [Measure] menu.
The laser will scan the object several times and 
AE and/or AF will be performed according to the 
settings in [AE/AF configuration].

2 A vertical black line appears on the moni-
tor window while AF is being performed.
The work is in focus when the vertical black line 
of the monitor window is aligned with the vertical 
green line indicating the center of the lens.

Vertical black line for focusing

Vertical green line for positioning

AE (Auto Exposure) and AF (Auto Focus)
AF (Auto Focus) is a mechanism for automatically setting the focal distance to the work. 
AE (Auto Exposure) is a mechanism for automatically setting image exposure conditions.
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Spot AF
If the target area is out of focus or outside of the scan area after AF, the spot AF feature can be used to bring it into focus.
With point AF, line up the mouse cursor with the location you want to focus on in the monitor screen, and then click the left 
mouse button. Scanning for spot AF begins when the mouse is left-clicked. When the targeted area is brought into focus, 
the scanning parameter settings of RANGE VIEWER are updated to the results obtained in spot AF. Spot AF ends when 
monitoring operations start.

Operating Procedure Shortcut    – Spot AF Button    

1 Click  [Spot AF] button. 

The icon in the monitor window changes to  .

Spot AF button

2 Left click at the position where you want 
to execute point AF.

Click target point.

3 Spot AF begins and the clicked location 
is brought into focus.

 Note
It is not a problem if spot AF results in the lens 
center (green) line at the window center and the 
black line not being aligned.

Vertical black line

Lens center (green) line
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Manual Focusing and Exposure Level Setting
The focus and exposure level can be adjusted manually for works that are hard to focus on with AE/AF or spot AF.

Operating Procedure Shortcut    – –

1 Set the measurement distance by clicking 
the  or  button at the side of the [Mea-
surement Distance] list box or inputting 
the number directly.
The stand-off distance can be set between 450 
and 800 mm. In the Multi focus mode, this range 
is 462 ~ 781 mm for TELE and 475 ~ 766 mm 
for WIDE. For correlations between stand-off dis-
tance and work size, see “Scan Position Adjust-
ment” on p. 42.

Distance list box

2 Slide the [Exposure] slider left and right 
to set the exposure level.
Adjust the exposure level according to the bright-
ness of the work. A low percentage (%) is effective 
for scanning bright works. Inversely, a setting a 
higher ratio is effective for scanning dark works.

Exposure slider

3 Select the number of scans from the 
[Number of scans] list box.

        

The number of scans can be selected from 1 to 
5.
The slider width varies with the number of mea-
surements set.
Each measurement covers 20% of the entire size.  
Setting 5 measurements gives a size of 100%.

 Supplement
The Scanning time displays the estimated time required for scanning. It is based on the Distance, Exposure level and •	
Number of scans.
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4.3	 Dark Surface mode setting
Measurement of objects with ultra-low reflectivity (the dark surface with 2.5% reflectivity), until now considered 
difficult using camera-type non-contact 3D digitizer, is now made easy using this industry-pioneering func-
tion.

 NOTE
The Dark Surface mode setting screen is unavailable in RANGE7 models which do not have the Dark Surface mode function.
Please warm up the sensor before use it. Low temperature may result in problems such as incomplete data.

Operating Procedure Shortcut 

1 Tick the Dark Surface mode checkbox  
under the “Exposure” slider.
The “Exposure” slider is automatically set to maxi-
mum. At the same time, the number of scans to be 
performed increases by 1 from the preset value.

2 The exposure level can be adjusted by mov-
ing the “Exposure” slider sideways.
Depending on the amount of light, you can manually 
adjust the exposure slider to get your desired expo-
sure for measuring objects.

*	 Adjusting the “Exposure” slider will cancel the  
Dark Surface mode setting; the indicator will 
change from  to  and the “+1” icon in the 
“Number of scans” field will disappear.

To return to the Dark Surface mode, reset the “Ex-
posure” slider to maximum.

*	 The Dark Surface mode indicator will restore 
from  to  and the “+1” icon in the “Number 
of scans” field will reappear.

3 Select the number of scans from the “Num-
ber of scans” list box.
The number of scans can be selected from 1 to 5. 
The number of scans automatically increases by 
1 in the case of a Dark Surface mode.
The slider width varies with the number of mea-
surements set in the same way as when you scan 
a work without ticking out the Dark Surface mode 
checkbox .

 Supplements
You may tick or not tick the Dark Surface mode checkbox •	  as you go along depending on the condition of the work 
surface to be scanned.
The checkbox •	  will not be displayed while the sensor is disconnected.
The Dark Surface mode will carry through to the next startup if remained it on at the end of the session; when you want •	
to carry out a regular scan next time, please do not tick the Dark Surface mode checkbox .
When a change is made to the number of scans while the Dark Surface mode is on, and if the exposure is set to maxi-•	
mum before the change, then it is automatically set to maximum after the change.
When the Dark Surface mode is switched on, there will be 8 seconds more than the time cost for the regular scan •	
displayed in the “Scanning time” field.

Number of scans
“Exposure” slider

Dark Surface mode checkbox

Number of scans
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AE/AF in Dark Surface mode
Using the AE function when scanning a dark surface 
will result in the exposure being set so that bright  
areas of the work are scanned.
In order to scan a black work, you are advised to set 
the scan setting to “AF only” using the “Scan settings” 
dialog, so that the AE function can be switched off.

Element information in Dark Surface mode
In the “Element information” dialog, for an element created using a scan in Dark Surface mode, the “Number of 
scans” field will display a “+1” in addition to the preset number of scans, for example, “4+1”.

Preview in Dark Surface mode
A dark surface preview (approx. 0.8 seconds / scan) is 
carried out when the Dark Surface mode checkbox  
is ticked and the exposure is set to maximum.

Set the AE/AF configuration to “AF only”



RANGE VIEWER Reference Manual

48

4.4	 Preview
The measurement results can be forecast with the 3D preview function.
This makes it possible to predetermine the depth in the measurement area and any blind spots before the 
actual measurement takes place, and it can greatly reduce measurement mistakes.

Operating Procedure Shortcut    F4 Preview Button    

1 Click the  [Preview] button or select  
[Preview] from the [Measure] menu.
The work is scanned at high speed and a preview 
of it is displayed in the preview window. The cap-
tured image can be checked using the menu but-
tons and mouse.

“Data-pre” appears in the element list when the 
preview feature is executed.

 Supplement
The data obtained in the preview is shown just •	
for checking beforehand.

Preview button

2 You can check the preview results with two 
types of 2D images on the monitor screen.
Monochrome image display
You can check the entire image for a main scan 
as a monochrome image.
Contour image display
You can check the data by looking at the color distribu-
tion, which corresponds to the measurement distance.
The color bar displays the correspondence between 
the colors displayed in the contour image and the 
measurement distances.
If the display colors are extremely biased, good 3D 
data cannot be obtained in the measurement scan.
The data is displayed as a distribution of colors, 
which correspond to the measurement distances.

 Show contours button
Show monochrome view button   

Color bar

Viewing mode is changed by these buttons.
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3 Preview data is deleted by clicking  
Delete last data button.

Delete last data button

Monitor Window

 
Show monochrome 
view button

Displays the scanned data in a monochrome view.

 
Show contours button The data is displayed as a distribution of colors, which correspond to the measurement 

distances.

 
Show color bar checkbox When a checkmark   is placed in the checkbox, A bar is displayed giving the corre-

spondence between the colors and the distances shown on the contour display.
Data close to the RANGE7/5 appears red and that 
far away is blue. The scale is evenly spaced across 
the distance from the RANGE7/5 to the focal point. 
Auto scaling is not performed according to depth.

Images with little change in distance change little 
in color.

 
Delete last data button Deletes previews and the last scanned element.

 Supplement
Switching of monitor screens can be executed by the shortcut below as well.•	
Monochrome image display button
Contours display button
Color bar display check button

Shift
Shift
Shift

M
C
V
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4.5	 Measure
Clicking  [Scan settings] button opens the Scan settings dialog box with the [Initial registration meth-
od] selected as the registration mode. During scanning, scanning time is monitored on a progress bar.
There are three registration modes: [Paired points], [Rotating stage] and [Marker]. 
Their features are outlines below:

[Initial registration  
method] Description Advantages Other

Paired points The position of a work 
is registered by left-
clicking correspond-
ing points of two 
scanned 3D images 
in order to interpolate 
their positions in 3D 
space.

Scanning is easy as special in-
struments and markers are un-
necessary.

–

Rotating stage The work is set on a 
rotating stage and au-
tomatically scanned 
to register its position 
in 3D space.

The axis of rotation requires 
simple calibration. The position 
of a work can be registered au-
tomatically.

SHOT-602* and SHOT-202 are applicable control 
boxes for the rotating stage.

Marker Markers are affixed 
to works and their po-
sitions are registered 
when they overlap in 
differing scan shots.

This mode is more accurate 
than [Paired points] and oper-
ability is improved because the 
marker information basically 
automates registration work.

Set marker size for the type of lens being used. Use 
[Small] for TELE and [Large] for WIDE.

Marker (Fixed) Markers are affixed 
to the work and the 
file containing the 3D 
coordinate values of 
the affixed markers is 
read in.
Marker registration 
is performed by the 
c o r r e s p o n d e n c e 
relationship between 
the markers in the 
scanned shots and 
those in the read file.

The 3D coordinate values of 
themarkers are given in the 
file.
Accordingly, errors do not ac-
cumulate with repeated regis-
tration compared to the normal 
marker registration.

Set the marker size according to the lens currently 
used. Small (for TELE lens), Large (for WIDE lens)
When scanning with markers (fixed), select [Mark-
er] from the initial registration and check [Not add-
ing new ref.].
Determine the 3D coordinate value of each marker 
by means of photogrammetry etc. before scanning 
and then save it in the file.
To record the 3D coordinate values of markers, rmk 
and TXT files can be used.
The markers scanned during scanning with mark-
ers (fixed) are not added to the reference markers.

 Scan Flow by Registration Mode          * All examples rotate the work 90˚ and take 4 scan shots.
[Paired points] 1st Shot 2nd Shot 3rd Shot 4th Shot

Data from 1st scan shot 
and 2nd scan shot are 
merged by selected 
point registration.

Data merged after 2nd 
scan shot is merged 
with data from 3rd scan 
shot by selected point 
registration.

Data merged after 3rd 
scan shot is merged 
with data from 4th scan 
shot by selected point 
registration.

[Rotating stage] 1st Shot 2nd Shot 3rd Shot 4th Shot

The stage is rotated 60˚ or 90˚ as per settings. Scanned data is automatically merged to obtain final 
scanned data.a

[Marker/Marker (Fixed)] 1st Shot 2nd Shot 3rd Shot 4th Shot
Unnecessary markers 
are deleted.

Data is merged auto-
matically using marker 
position information. 
Unnecessary markers 
are deleted.

Data is merged auto-
matically using marker 
position information. 
Unnecessary markers 
are deleted.

Data is merged auto-
matically using marker 
position information. 

1 2 2 3 3 4 4 1

RANGE7/5
Work

1 2 2 3 3 4 4 1

RANGE7/5

Work

Affix markers of size 
that suits type of lens.

1 2 2 3 3 4 4 1

RANGE7/5

Work

Rotating stage
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Before Scanning
Before scanning, it is necessary to set up scanning, registration mode and other parameters. For details, see 
“4.6 Scan settings” on p. 67.

A.	 Registration by [Paired points] Mode

Operating Procedure

1 Click  [Scan settings] button 
to open the Scan settings dialog box, 
and select [Paired points] under [Initial  
registration method].  

2 Click  [Monitor] button and adjust 
the location and posture of the RANGE7/5 
and work while monitoring the work.
See “4.1 Monitor” on p. 41

Monitor button

3 Click  [AE/AF] button to set the 
stand-off distance and exposure. 
See "4.2 AE/AF " on p. 43.

AE/AF button

4 Click  [Preview] button to check 
the preview image.
See “4.4 Preview” on p. 48. Preview button

5 Click  [Scan] button or select 
[Scan] from the [Measurement] menu.

Scan button

6 The Scanning dialog box appears and 
scanning starts.
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7 Scanning ends as per settings.

Displays the measured 3D images on the select-
ed screen and measured screen. 
A name appears in the element list for the ac-
quired data.

8 Rotate the work to another angle and ad-
just location and posture while monitor-
ing.

Monitor button

9 Click  [Scan] button or select  
[Scan] from the [Measure] menu.
The Scanning dialog box appears and scanning 
starts.

Scan button

10 Scanning ends as per settings.

The second scanned data are displayed on the se-
lected screen.  
The second scanned data name is displayed in the 
element list as selected. 
In addition, scanned data after the second data are 
not displayed on the scanned screen until registra-
tion is complete.
However, checking the check box manually en-
ables the data to be displayed on the scanned 
screen.
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 Supplement
If positions do not align properly, add a pair of corresponding points and register the positions again.•	
Preview data obtained by •	 clicking the preview button can be aligned with already scanned elements.
If scanning is executed immediately after positioning preview data, the preview data is automatically registered with the •	
scanned element.
Because registration is complete even though it is immediately after scanning, a checking mark is put in the check box 
and the element is displayed on the scanned screen.
Rotate works to a profile that makes it easy to select corresponding points.•	
After the measurement, in case preview or measurement is done without paired points registration, the message “Try-•	
ing to preview (measure) without paired points registration, do you continue to preview (measure)?” is displayed. Press 
the [No] button, and stop preview or measurement. By pressing the [Yes] button, preview or measurement continues.

11 Click  Set registration points button. 

The pointer changes to  when preparations for 
selecting points are complete.

12
Click sequentially on the corresponding 
points in the two images.
Perform the registration by designating the corre-
sponding positions of the second measured data 
(left) and the first measured data (right). Click as 
close to the same point as possible in the left and 
right images.

When the pointer looks like , right-clicking the 
mouse opens a pop-up menu of the following 
commands.

Selecting [Undo] deletes clicked points in back-
wards order from the most recent. 

Selecting [Pause] pauses clicking and enables 
you to rotate and zoom the 3D images.
To start again, select interruption from the popup 
menu again. In addition, interruption and restart-
ing can be done by pressing the [Space] key.

Selecting [Cancel] cancels the selected points 
registration mode regardless if any points have 
been selected or not.

You can select points sequentially in either of the 
images first and then in the other image. Marker 
colors change sequentially with each click.

13 Once one or more pairs of correspond-
ing points have been selected, select  
[Done] from the pop-up menu opened by 
right-clicking the mouse, to register the 
points.
Scanned data finished with registration are 
automatically displayed in the scanned window.

Condition where registration is executed.
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14 Continue and repeat scanning from 
different directions.

     The third scanned data

2 data already registered by 

15 Click  [Paired Points Registration]  
button.

The icon becomes  , and corresponding points 
can be selected. 

Click corresponding positions of the data displayed 
on the selection screen and scanned screen, then 
register. 

At this stage, paired points can be performed to 
all the plural number of data displayed on the 
scanned screen.

16
When clicking more than one pair in 
corresponding positions, registration 
is executed by selecting [Execution] in 
the pop-up menu provided by the right 
mouse click. 
Scanned data finished with registration are auto-
matically displayed in the scanned window.

With regard to element information, if colors of 
elements change, registration results become 
easier to see. (“3.4. Element information” p. 39 – 
40)

Condition where registration is executed.
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17 The data which was registered once can be 
registered again by selecting them in the element 
list.
Displays data selected from the element list are 
displayed in the Selection screen.

18 By clicking  Paired Points Registration] in this 
condition, registration can be done again for the 
data [Data-1] which was registered once.

Note: �Data obtained by preview cannot be used 
as the bases for registration even though 
they are displayed on the scanned screen. 
Selected data themselves are not used as 
bases of registration. 
Therefore, these data automatically 
become [Non-display] to avoid displaying 
them on the Scanned screen (to disable 
clicking of corresponding points) 
during the work of paired points.  

Data moved by registration

Data scanned in review

Start paired points registration

Check is turned off so as not 
to display data in the scanned 
screen automatically while 
registration.  



RANGE VIEWER Reference Manual

56

B.	 Initial Registration with Use of a Rotating Stage
Using the rotating stage to measure the object and determining the rotation axis with the calibration chart results in 3D 
data on a specific circle.
By using this as the measured data, and repeating the initial alignment with other 3D data on other circles, you can obtain 
full-circle 3D data with minimal measurement omissions.

Setup for Registration Using a Rotating Stage
This setup is for registering works in 3D space using a rotating stage.

Operating Procedure

1 Click  [Scan settings] button to 
open the Scan settings dialog box, and 
select [Rotating stage] under [Initial  
registration method].
This operation activates the [Stage] group of set-
tings.

2 Set the communication port for the con-
troller of the rotating stage.
The controller can be selected between [SHOT-
602] and [SHOT-202] from the [Model] list box in 
the [Stage] group of settings. Select the controller 
connected to the computer.
Select a communication port to connect the con-
troller from the [Port] list box in the [Stage] group 
of settings.

3 Click the [OK] button.

The rotating stage is initialized.

If the Rotating Stage Is Not Recognized•	

An error message appears stating, “Unable to communicate with stage.” 
In this case, switch the control box power Off, then On again and re-do the operation from the start.

If the Rotating Stage Is Recognized and Successfully Initialized•	

If the computer does not contain a file of the axis of rotation data, a message appears stating, “No stage axis 
information exists. Please measure a chart.” 

If the computer has a file of the axis of rotation data, it is automatically read and the information on the registered 
instrument and lens is checked.

• If the registered instrument and lens in that axis of rotation data differ from the current instrument and lens, 
a message appears stating, “Conditions differ from when the chart was scanned.” 

• If the registered instrument and lens in that axis of rotation data are the same as the current instrument and 
lens, a message appears stating, “Axis of rotation data has been loaded.” 

  (Note: This message appears as long as the instrument and lens match the registered data even if calibra-
tion is needed because the stand-off distance has changed from when the axis of rotation data was last 
calibrated. Accordingly, when this message appears, it is not guaranteed that the loaded axis of rotation data 
is appropriate.)
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Rotating Stage Calibration
The axis of rotation data needed to automatically register the scanned data of a work turned on a rotating 
stage is calculated by scanning the calibration chart. The resulting axis of rotation data is automatically saved 
as a file in the computer for use the next time that  [Use rotating stage as initial registration method] is set.

Operating Procedure

1 Set the calibration chart “S” or “L” on the 
rotating stage and click  [Monitor] 
button. 

Calibration chart “S”
 or “L”

Position and posture the instrument and the rotat-
ing stage so that the calibration chart appears in 
the monitor window as shown at right.

(Note: Prior to calibration, if the rotating stage is 
not at the first angle (0))̊ ), move the [Rotation 
Angle] slider to 0˚ to return the stage to 
the 0˚ angle.)

Projections are aligned with the 2 holes.

Rotating stage

2 Click the AE/AF button to adjust the 
stand-off distance and exposure.

Adjustments are made as determined by the [AE/
AF configuration] setting on the Scan settings 
dialog box. See “4.6 B. Scan settings for Rotating 
Stage Registration” on p. 70.

3 Click  [Preview] button. 

Check the distance image of the calibration chart 
in the preview window looks like the Good exam-
ple at right. If it looks like the Bad example, return 
to step 2 .

    Good example           Bad example
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4 Click  [Stage calibrate] button. 

Stage calibrate button

When clicked, a message appears asking, “Ready 
to initialize stage and scan chart?”

Clicking the [Yes] button rotates the stage to the 
first angle.

Clicking the [No] button cancels rotating stage •	
calibration.

5 A message appears asking, “Scan chart 
image?”
Clicking the [OK] button starts calibration chart 
scanning.

Clicking the [Cancel] button cancels rotating •	
stage calibration.

6 The calibration chart is scanned.

When scanning has been completed, a message 
appears asking, “Use this image?”

Clicking the [Yes] button calculates the axis of ro-
tation data and saves it as a file. The saved data 
is used the next time registration is done using the 
rotating stage.

If no data was obtained at all, a warning message 
will appear.

Note: �When using the rotating stage by 
setting RANGE7/5 vertically, place it 
in the physical relationship. where the 
acceptance lens is above the rotating 
stage, and the laser projection window 
is below the stage.
By setting the acceptance lens below, 
counter-rotated data can be obtained.



59

Startup

  

1

2

3

4

5

6

 Error 
Messages

Menu
Items

Glossary

Index

File

Edit

View

Measure

Instrument

Help 

Window
Configu-
ration

Registration Using a Rotating Stage
If scanning is started without any existing scanned data, the full-perimeter data of a work is obtained by ro-
tating the work around the axis of rotation using the acquired axis of rotation data and scanning it at various 
angles on the rotating stage.
This axis of rotation data is calculated as explained in “Rotating Stage Calibration” and loaded as explained in 
“Setup for Registration Using a Rotating Stage”.

Operating Procedure

1 If you performed the steps in “Rotating 
Stage Calibration”, remove the calibra-
tion chart and set the work on the rotat-
ing stage.

2 If you loaded the axis of rotation data as explained in “Setup for Registration Using a Rotating 
Stage” without calibrating the rotating stage, calibrate the stage to obtain the most recent axis 
of rotation data in the following cases.

Rotating Stage Must Be Calibrated Comment
1 If the message “Cannot find the corresponding axis 

of rotation data.” appears –

2 If the message “Conditions differ from when the chart 
was scanned.” appears –

3 If the message “Axis of rotation data has been 
loaded.” appears, but the positional relationship of 
the rotating stage and instrument differs from when 
the axis of rotation data was obtained

This message does not guarantee that the axis 
of rotation data is appropriate. (See step 3  of 
“Setup for Registration Using a Rotating Stage” 
p. 56.)

If the message “Axis of rotation data has been loaded.” appears and the positional relationship of the rotating 
stage and instrument is the same as when the axis of rotation data was obtained, use the loaded axis of rotation 
data. 
Note: �Calibrate the rotating stage if any displacement in the [Use rotating stage as initial registration method] data 

appears when the loaded axis of rotation data are used.

3 Click  [Scan] button and do the 
following based on the step angle.
If Not Using Free Step Angles
Scan at the current angle, display the scanned re-
sult in the 3D view window and turn the stage to 
the next angle.

If Using Free Step Angles (* Free step angles 
cannot be selected in full auto scanning.) :
Scan at the current angle and display the scanned 
result in the 3D view window. 
Do not turn the stage. With free stepping, use the 
slider bar to turn the stage to a specific angle.

If Using [Auto scan] :
Start the measurement from the 0˚ angle, and 
then automatically measure one complete circle 
according to the step angle.
When you measure the data for one circle, the ro-
tation stage returns automatically to the 0˚ angle.

Work

Rotating stage
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Note: Clicking the [Cancel] button that appears on 
the Scan dialog box during scanning stops scanning 
and rotating stage rotation.  To change the angle, 
do so from the [Rotation Angle] slider.

(Example of scanning at 90˚ steps)

90˚

180˚

270˚

4 When the scanning for one circle is  
complete, the rotation stage stops and 
measurement ends.
The scanned 3D image appears in the preview 
window. 
A name appears in the element list for the  
acquired data.
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Setup for Full Auto Scanning
To use full auto scanning, place a checkmark in the [Auto scan] checkbox. 
* When full auto scanning is used, At the start of measurement, by just clicking the [Measure] button once, 
you can measure automatically until the measurement for one circle is complete and the stage is aligned at 
the initial position.

Operating Procedure

1 Place a checkmark in the [Auto scan] 
checkbox on the scan window.

[Auto scan] checkbox

2 Click the  [Scan] button to open 
the [Auto scan settings] dialog box.

When there are no measured data yet, the [Regis-
ter by paired points] checkbox is grayed out.
If scanned data exists, data scanned at 0˚ can be 
interpolated to the existing scanned data by plac-
ing a checkmark in the [Register by paired points] 
checkbox.

3 To use AE/AF for each scan shot, place a 
checkmark in the [Perform AE/AF] check-
box and select a mode from the list box.

AE/AF are not performed if the [Perform AE/AF] 
checkbox is not checked.
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4  Click the [OK] button.

If a checkmark is not placed in the [Register 
by paired points] checkbox.

The rotating stage angle is initialized at 0˚ and the 
full perimeter of the work is scanned automati-
cally at the set step angles. When data has been 
obtained for the full perimeter, the rotating stage 
returns to 0 .̊

If a checkmark is placed in the [Register by 
paired points] checkbox.

•	 The rotating stage angle is initialized at 0˚ and, 
after obtaining scan data for 0 ,̊ scanning stops 
so as to interpolate the data by selected points 
registration.

•	 Clicking the [Set registration points] button per-
forms paired points registration.

•	 After selected points registration has been com-
pleted, clicking the [Scan] button starts full auto 
scanning.

•	 Scanning is automatically performed for the re-
maining step angles. When data has been ob-
tained for the full perimeter, the rotating stage 
returns to 0 .̊

Note: Clicking the [Cancel] button that appears  
in the [Scan] dialog shown during full auto scan-
ning stops scanning.

Scanning is automatically performed for the 
remaining step angles. 
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Registration combining rotating stage registration and measurement from different positions

Groups of data registered around the axis of rotation can be registered even after changing the RANGE7/5 position by 
following the specified procedure. Using this feature can provide full-perimeter 3D view results with fewer gaps in the 
scanned data.

Method 1: Method in which the rotating stage is not calibrated at each different instrument position

With this method, repeated registration around the axis of rotation (with the instrument position changed in order to scan 
the work on the rotating stage from different angles for example) is performed to create a full-perimeter 3D view without 
calibrating the rotating stage each time the instrument position is changed.

The procedure is as follows

Procedure Illustration

Step 1 1.	Place the instrument, rotating stage and scanning 
works in any position (Position1).

2.	Start scanning and registration using the rotating 
stage from a rotating stage angle of 0 degrees with-
out any prior data present. 

3.	Registration of first series of data is performed. 
(Data group A)

Step 2 1.	Change the instrument position (Position 2). Do not 
change the positional relationship between the work 
and the rotating stage.

2.	Scan at a rotating stage angle of 0 degrees.
3.	Perform selected points registration of the new data 

just scanned at an angle of 0 degrees to one of the 
first 0-degree data scanned in Step 1 (Data group A) 
as a reference.

4.	Scan data at remaining rotating stage angles. Data 
are registered around the axis of rotation.

Step 3 Repeat Step 2 as many times as necessary.
–
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Method 1 cannot be used in the following cases.

Method 1 Cannot Be Used Comment

1 If the work was moved
 Use method 2.

Also, use method 2 for all subsequent scan shots until scan-
ning the full perimeter.

Point
If only the step angle is changed in scanning 
without repositioning the work on the stage, the 
stage does not require calibrating. (Selected 
points registration is unnecessary.)

2 If another method of registration is used than selected points 
registration

 Use method 2.
Also, use method 2 for all subsequent scan shots until scan-
ning the full perimeter.

Point
Delete all scanned data from the ele-
ment list in order to perform regis-
tration using method 1 again

3 If all scanning is done using a rotating stage for registration 
and existing scanned data from the element list that contains 
data loaded from rgv or rvm files as reference

Point
Even if the rgv or rvm file contains data regis-
tered using a rotating stage, it cannot be used.

4 If all scanning is done using a rotating stage for registration af-
ter calibrating the rotating stage or loading axis of rotation data 
when existing scanned data exists in the element list

–

Method 2: Method in which the rotating stage is calibrated at each different instrument position
With this method, new data can be registered to any existing data. Use this method when registration by Method 1 could 
not be performed.
The procedure is as follows

Procedure Illustration

Step 1 1.	Place the instrument, rotating stage and scanning 
works in any position (Position1).

2.	Start scanning and registration using the rotating 
stage from a rotating stage angle of 0 degrees with-
out any prior data present. 

3.	Registration of first series of data is performed. 
(Data group A)

Step 2 1.	Change the positional relationship between the work 
and the rotating stage (Position 2). (The instrument 
position can also be changed.)

2.	Calibrate the rotating stage.
3.	Scan at a rotating stage angle of 0 degrees.
4.	Perform selected points registration of the new data 

just scanned at an angle of 0 degrees to one of the 
first 0-degree data scanned in Step 1 (Data group A) 
as a reference.

5.	Scan data at the remaining angles. Data are regis-
tered around the axis of rotation.

Step 3 Repeat Step 2 as many times as necessary.
–
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C.	 Initial Registration with Markers/Markers (Fixed)
The position of a work in 3D space can be automatically registered by affixing markers to the work and identi-
fying where the markers overlap in differing scan shots.
Registration is performed by automatically recognizing the markers read out from the file containing the 3D 
coordinates of the markers and the markers of the scanned shot.
The markers scanned during scanning with markers (fixed) are not added to the reference markers.

Operating Procedure

1 Click  [Scan settings] button to 
open the Scan settings dialog box, and 
select [Marker] under [Initial registration 
method].
When scanning with markers (fixed), please check 
[Not adding new ref.].

2 Affix either large or small markers to the 
work.

* Only [Large (for WIDE lens)] can be used for RANGE5.

Space the markers apart so that about 5 ~ 10 ap-
pear on the monitor window during scanning. Set 
marker size according to the type of lens being 
used.
[Small]: TELE, [Large]: WIDE
Before scanning with markers (fixed), determine 
the 3D coordinates of the stuck markers by means 
of photogrammetry etc. and save them in an rmk 
or txt file, and then read the markers out of that file 
with the [Read out reference] button.

3 Click  [Monitor] button and adjust 
the location and posture of the RANGE7/5 
and work while monitoring the work.
See “4.1 Monitor” on p. 41.

Monitor button

4 Click  [Preview] button to check 
the preview image.
See “4.4 Preview” on p. 48. 
Check in the 3D view window that preview data 
from the second and subsequent scan shots can 
be automatically registered.

Preview button

5 Click  [Scan] button or select    
[Scan] from the [Measure] menu.

The Scanning dialog box appears and scanning 
starts. The recognized markers are captured and 
collected as reference markers.

Scan button
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6 Once scanning has been completed, de-
lete unnecessary marker information in 
the monitor window.
You can specify a range and select markers by ei-
ther clicking the misrecognized marker or a mark-
er you want to delete with the left mouse button 
or by dragging the cursor while holding down the 
left mouse button. When selected, these markers 
appear red.
Left-clicking the selected markers again unselects 
them.
After selecting a marker to delete, click the right 
mouse button to display the pop-up menu and 
then select [Delete Selected Marker] to delete the 
selected marker.
Right-clicking the marker on the 3D view displays 
the popup menu. Selecting [Delete] deletes the 
selected marker.

7 Perform the next scan shot.

Position the work so that at least three (preferably 
five or more) markers overlap and are common 
to both the scanned element and upcoming scan 
shots.

Repeat steps 2 ~ 6  to obtain the necessary 
data.

Point
Saving Reference Markers (See p. 71.)
Click the [Save ref.] button in the Scan settings 
dialog box. The reference markers are saved as 
a rmk file. Also, you can resume interrupted op-
erations by clicking the [Open ref.] button to recall 
saved reference markers (rmk file).

Function to read out reference marker (See p. 71.)
Registration can be started again with the interrupted 
"markers" by reading out the saved rmk file.
Also, since the 3D coordinates of each marker 
affixed to the work can be determined, registration 
can be performed with "markers (fixed)".
The files that can be read out are rmk file and txt 
file. The rmk file has an original format.
In the format of the txt file, the X coordinate value, 
Y coordinate value and Z coordinate value of 
the 3D coordinates of the marker are entered in 
each line.  Each coordinate value is separated by 
commas or tabs.
Creating New Reference Markers (See p. 71.)
To delete all captured reference markers, as might the case when ready to scan a new work, click the [New ref.] 
button. All reference markers are deleted.
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[Scan settings] dialog box

4.6	 Scan settings
Scan settings are controlled by the Scan settings dialog box that is opened by clicking  [Scan settings] 
button, and the  (scan) tab of the main window. The number of scans, stand-off distance, exposure level 
and rotating stage drive settings (This is only displayed when the rotating stage is used.) are set on the scan 
tab. The exposure is automatically set to the best level for the set conditions (i.e., number of scans, etc.) when 
AE is executed. 

Operating Procedure Shortcut    Shift+F6 Scan settings Button  

1 Click  [Scan settings] button or 
select [Scan settings] from the [Measure] 
menu.
The Scan settings dialog box appears. 
Scan settings are set on the Scan settings dialog 
box and scan tab of the main window.

2 Select an AE/AF mode from the [AE/AF 
configuration] list box.

[AE and AF]	 AE/AF mode
[AE only]	 AE only mode
[AF only]	 AF only mode

3 Select [Enable] or [Disable] from the  
[Multi focus] list box.

[Enable]:  �Automatic scanning using multiple focal 
points

[Disable]: Focal point does not move.

4 Select a data reduction ratio from the 
[Data reduction ratio] list box.
Select a reduction ratio from [1/1], [1/4], [1/9] 
and [1/16]. Since the number of data in the origi-
nal element is deleted for scanning, the data  
reduction ratio of the scanned data cannot be 
changed.

5 Select a registration mode from the  
[Initial registration method] list box.
Select a registration mode from  [Paired points], 
[Rotating stage] and [Marker]. Once a mode has 
been selected, parameters must be set for the se-
lected mode.

6 Click the [OK] button to close the Scan 
settings box.

To save settings, click the [Save settings] but-•	
ton.
To cancel settings, click the [Cancel] button.•	

 Supplement
Clicking the [Load settings] button loads the settings 
saved via the [Save settings] button.
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Scan settings Dialog Box * Other parameters are discussed on p. 69 ~ 71.

[Save settings] button 	 Saves scan settings on the hard disk.	

[Load settings] button 	 Loads scan settings from the hard disk.		

[OK] button 	 Updates settings changes (applies them to the instrument) and closes the 
Scan settings dialog box.

[Cancel] button	 Changing of scan settings is canceled. The settings for scanning are returned 
to the settings that were in effect at the time the dialog was opened, and the 
dialog will close.

AE/AF
AE and AF configuration must be set to focus and expose works for registration processing. To perform only AF, 
select [AF only]. AE can be performed in conjunction with AF particularly when working with works that are dark 
or bright (shiny) so as to automatically set exposure to the best level.

But, using the AE function when scanning a dark surface will result in the exposure being set so that bright areas 
of the work are scanned. In order to scan a black work, you are advised to set the scan setting to “AF only” using 
the “Scan settings” dialog, so that the AE function can be switched off. 

AF is difficult with the following works.
1. Works of equal size overlapping from front to back    2. Works with fence-like structures at the front

                                 
When using AF with these kinds of works, the best focal distance is not always determined. In these cases, spot AF 
is effective. Clicking the spot AF button starts monitoring and displays the monitored image in the 2D view window, 
therefore a point for focusing the image can be selected by clicking the mouse pointer somewhere on the image. 
Monitoring makes it easy to check the image after spot AF. 

Cases Where Spot AF Is Unsuccessful
1. If the mouse is clicked on a point off the work     2. �If the mouse is clicked on a point at an extremely close 

distance

                                            
If an error message appears, adjust the location and posture of the work.

The focus and exposure level can be adjusted manually for works that are hard to focus on with AE/AF or spot 
AF. The exposure level can be set to 0 ~ 100% of the brightness of the work. A low percentage (%) is effective for 
scanning bright works. Inversely, a high setting is effective for scanning dark works.
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A.	 Scan settings for Paired Points Registration

Operating Procedure Shortcut    F6 Scan settings Button  

1 Click  [Scan settings] button or
select [Scan settings] from the [Measure] 
menu.
The Scan settings dialog box appears.

2 Select an AE/AF mode from the [AE/AF 
configuration] list box.
[AE and AF]	 AE/AF mode
[AE only]	 AE only mode
[AF only]	 AF only mode

3 Select [Enable] or [Disable] from the  
[Multi focus] list box.
[Enable]:  �Automatic scanning using multiple focal 

points
[Disable]: Focal point does not move.

4 Select a data reduction ratio from the 
[Data reduction ratio] list box.

Select a reduction ratio from [1/1], [1/4], [1/9] 
and [1/16]. Since the number of data in the 
original element is deleted for scanning, the data  
reduction ratio of the scanned data cannot be 
changed.

5 Select [Paired points] from the [Initial  
registration method] list box.

6 Click the [OK] button to close the Scan 
settings box.

Scan settings Dialog Box 

Registration/Stage configuration

AE/AF configuration 	 Sets AE/AF mode from [AF only], [AE only] and [AE and AF].

	 Multi focus	 Enables/Disables automatic scanning with multiple focal points. When en-
abled, if the stand-off distance in the scan window exceeds the focal range of 
the Multi focus mode, it is set within this focal range (“Scan Position Adjust-
ment” on p. 42) when the [OK] button is clicked.		

	 Data reduction ratio	 The data can be reducted when they are scanned. Select a reduction ratio 
from the drop-down list. Selectable items: 1/1, 1/4, 1/9 and 1/16 

		  Note: Since the number of data in the original element is deleted for scanning, 
the data reduction ratio of the scanned data cannot be changed. [Related item: 
[Element display reduction ratio] p. 18]

		  For 1/4 deletion, the algorithm which leaves the edge part as much as possible 
is applied. 

Initial registration method 	 Sets the registration mode between [Paired points], [Rotating stage] and 
[Marker].
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B.	 Scan settings for Rotating Stage Registration

Operating Procedure Shortcut    F6 Scan settings Button    

1 Click  [Scan settings] button or 
select [Scan settings] from the [Measure] 
menu.
The Scan settings dialog box appears.

2 Select an AE/AF mode from the [AE/AF 
configuration] list box.

[AE and AF]	 AE/AF mode
[AE only]	 AE only mode
[AF only]	 AF only mode

3 Select [Enable] or [Disable] from the  
[Multi focus] list box.
[Enable]:  �Automatic scanning using multiple focal 

points
[Disable]: Focal point does not move.

4 Select a data reduction ratio from the 
[Data reduction ratio] list box.
Select a reduction ratio from [1/1], [1/4], [1/9] 
and [1/16]. Since the number of data in the 
original element is deleted for scanning, the data  
reduction ratio of the scanned data cannot be 
changed.

5 Select [Rotating stage] from the [Initial 
registration method] list box.

6 Select items from the [Model], and [Port] 
list boxes under [Stage].

For parameter details, see “Scan settings” Dialog 
Box below.

7 Click the [OK] button to close the Scan 
settings box.

Scan settings Dialog Box

Registration/Stage configuration

For AE/AF setting, Multi focus and data sub-scanning rate, see "A. Scan setting for scanning by paired point  

registration"

Initial registration method 	 Select the initial registration method for scanning from [Paired points registration], 
[Rotary stage] and [Markers].

Stage	 Available only when [Rotating stage] is selected for [Initial registration method].
	 Model	 Selects the rotating stage controller. Selection can be made from SHOT-602, 

SHOT-202.
	 Port	 Sets the RS communication port that connects to the rotating stage. Available 

settings vary according to the PC environment.
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C.	 Scan settings for scannig with Markers/Markers (Fixed)

Operating Procedure Shortcut    F6 Scan settings Button  

1 Click  [Scan settings] button or 
select [Scan settings] from the [Measure] 
menu.
The Scan settings dialog box appears.

2 Select an AE/AF mode from the [AE/AF 
configuration] list box.
[AE and AF]	 AE/AF mode
[AE only]	 AE only mode
[AF only]	 AF only mode

3 Select [Enable] or [Disable] from the  
[Multi focus] list box.
[Enable]:  �Automatic scanning using multiple focal 

points
[Disable]: Focal point does not move.

4 Select a data reduction ratio from the 
[Data reduction ratio] list box.
Select a reduction ratio from [1/1], [1/4], [1/9] 
and [1/16]. Since the number of data in the 
original element is deleted for scanning, the data  
reduction ratio of the  scanned data cannot be 
changed.

5 Select [Marker] from the [Initial  
registration method] list box.

6 Select items from the [Marker size] list 
box under [Marker]. 
For parameter details, see “Scan settings Dialog 
Box” below.

7 Click the [OK] button to close the Scan 
settings box.

Scan settings Dialog Box 
Registration/Stage settings 

For AE/AF setting, Multi focus and data subscanning rate, see "B. Scan setting for scanning on rotary stage".

Initial registration method 	 Select the initial registration method for scanning from [Paired points registration], 
[Rotary stage] and [Marker].

Marker	 Available only when [Marker] is selected for [Initial registration method].
	 Marker size 	 Sets the marker size.
	 [New ref.] button	 Creates new reference markers. All reference markers in memory are discard-

ed and the reference marker list is cleared.
	 [Open ref.] button 	 Loads reference markers from the file. All reference markers in memory are dis-

carded and the reference markers saved as a rmk file are read from the file to 
memory. 

	 [Save ref.] button 	 Saves the reference markers as a file. The reference markers in memory are 
saved as a rmk file.

	 Not adding new ref. 	 If there is a file containing 3D coordinates of markers determined by photo-
grammetry etc., check the box. If the box is checked, registration with "mark-
ers (fixed)" is performed. The markers scanned during scanning with markers 
(fixed) are not added to the reference markers.

[Small] (For TELE lens) [Large] for WIDE lens
Inner diam. 5 mm, 

Outer diam. 8 mm 
Inner diam. 6 mm, 
Outer diam. 10 mm

 Memo  Only the large one (for WIDE lens) can be used for RANGE5.
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5.	Instrument
WARNING
Do not look directly into the laser emission window.
Keep lenses, objects with mirror-like surfaces and optical elements out of the optical path. 
These objects can focus the laser beam, resulting in damage to eyes, fire and burns. Also, to 
prevent inadvertent accidents, situate works in front of a wall or other structure that shields 
the laser beam.

5.1	 Calibration
Calibration reduces errors caused by environmental chang-
es or changes over time. 
Calibration should be performed if ambient temperature has 
changed since the last time the instrument was calibrated. If tem-
perature changes ±1.5˚C from the time of calibration, RANGE 
VIEWER displays a warning to prompt you to perform calibration.
When scanning is executed while a warning mark is ON, a warning dialog is displayed before starting to scan.
To avoid the display of the warning dialog, check when warming up is complete in the condition where no temperature change 
takes place in the environment at a certain temerature. Make sure to scan in the same temperature environment.

Calibration is unnecessary when lenses are interchanged. (Calibration is required after interchanging lenses if tempera-
ture has changed since the last time the instrument was calibrated with the newly mounted lens.)

Before Calibration (Calibration Set)
The calibration set includes the following.

Calibration sheet Calibration chart Calibration stand 

1280 x 430 (mm) plastic sheet. Sufficient 
space to spread out the calibration chart is 
required.

Do not touch the front side of the chart with 
bare hands.

Supports the RANGE7/5.

RANGE7/5 position

             For calibration with WIDE lens

            For calibration with TELE lens

The chart can be tilted to three set angles by 
pulling the knob on the left face of the chart 
stand. The stand makes it easy to establish 
the angles shown in the RANGE7/5 Calibra-
tion Wizard.

How to use

Calibration setup•	

*  The RANGE7/5 can be 
calibrated on its scan-
ning stand without using 
the calibration stand.
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1 Prepare the RANGE7/5 and calibration 
sheet.
Calibration with Only the RANGE7/5

Spread the calibration sheet out on a table.•	
Set the calibration stand on the sheet where in-•	
dicated by the picture. Position the stand’s legs 
in the three circles.
Set the RANGE7/5 on the stand.•	

 

 

Calibration with the RANGE7/5 on the Scan-
ning Stand
Spread the calibration sheet out on a table.

Spread the sheet out so that the edge of the •	
RANGE7/5’s body comes to the edge of the 
table.

Hold the RANGE7/5 level and adjust the height so 
that the bottom of the scanning stand pan head 
almost contacts the tabletop.

Anchor the RANGE7/5 securely to the pan •	
head with the bottom of the pan head above the 
tabletop.
Loosen the stand pan head enough that it can •	
rotate around the optical axis. Then, lower the 
stand arm with the RANGE7/5 mounted on it 
until the bottom of the pan head is flush with the 
tabletop. Determine the direction and height of 
the RANGE7/5 and lock in place.

Fine-adjust the position of the RANGE7/5.
Move the stand so that the RANGE7/5 is on the •	
picture on the calibration sheet. 
(Note: Be careful not to contact the stand legs 
with the table legs.)

2 Prepare the calibration chart.

The chart can be titled to three set angles by 
pulling the knob on the left face of the chart 
stand.
The stand make it easy to establish the angles 
shown in the RANGE7/5 Calibration Wizard.

Operating Procedure Shortcut    F8 –

RANGE7/5

Calibration  
stand

3 dots

Tabletop

Table edge

Bottom of scanning 
stand pan head

Knob on left face
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3 Select [Calibration] from the [Instrument] 
menu.
The Calibration Wizard appears.

Set the calibration chart in a position suitable for 
the type of lens. For a WIDE lens, the chart should 
be placed in position  nearest the RANGE7/5. 
For a TELE lens, it goes in position  farther from 
the RANGE7/5.
Once the calibration chart has been set, click the 
[Next] button.

Fine-position the chart.

Monitor window

Red boxes

Outside rows of dots

While watching the monitor screen, finely adjust 
the position of the calibration chart and RANGE7/5 
so that 24 O’s fit into the outermost side of the 
area sandwiched between the two red box lines. 
Make sure the outside dots do not cross the out-
side red frames.

Using the Stand Pan Head
Adjust the stand in the height direction from the tilt 
lever, and lock in place.
In the horizontal direction, either fine-adjust the 
stand’s position or reposition the calibration 
chart.

Using the RANGE7/5 and Calibration Stand
Adjust the calibration stand in the height direction 
from the tilt lever.
In the horizontal direction, either fine-adjust the 
stand’s position or reposition the calibration 
chart.
Note: As long as the outside rows of dots fit be-
tween the two red boxes, problems are not caused 
by the calibration chart being slightly displaced 
from the picture on the calibration sheet.

Swing angle 
adjusting lever
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OK

Once positions have been set, click the [Next] but-
ton.

NG (Outside row of dots cross outside red frame.)

4 Scan at position . Before scanning, after positioning

Check that the angle of the calibration chart sur-
face is like the picture in the Calibration Wizard. If 
OK, click the [Scan] button.

Verify results on the check screen.

Example of poor results: 

The [Monitor screen] on the check screen shows 
the scan results. Compare these results with the 
[Sample results].

 Memo
About the dots on the "Monitor Screen".

Is not the dot notched?•	
If the color is same colors as that shown in the •	
"Sample" on the right side, the position is cor-
rect.

If there is no problem, click the [Next] button. 
Position 1 scan data will be made valid.

If there is a problem, click the [Retry] ,after the 
position is adjusted.

 Note
For the possible problem and the solution method, 
refer to the column in page 76-77.

When the [Retry] button is clicked, a message •	
requesting confirmation of whether or not to dis-
card the most recent measurement data will be 
displayed. 
Click the [OK] button to perform a retry. •	
[Cancel] button to cancel the retry and return to •	
the previous screen.

Monochrome image on screen.
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Possible problem and the corresponding solution method

Example1)

State:	 Several dots are missing.
Cause:	 Exposure level problem.
Action:	Readjust exposure level and perform retry.

Example2)

State:	 3 colors of dots are shown.
Cause:	 Calibration chart is at an angle instead of directly facing the RANGE7/5.
Action:	Adjust the positions of the RANGE7/5 and calibration chart so that they directly face each other and 

perform retry.

Notched dots
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Example 3)

State:	 The color is different than the dot colors of the sample.
Cause:	 Improper distance.

The direction of distance shift is different according to the color of dots.
Almost all dots are red: Range7/5 is too close to calibration chart.•	
Almost all dots are red: Range7/5 is too far from calibration chart.•	

Action:	Handle the problem according to the direction of distance shift as follows
Almost all dots are red.•	
Move RANGE7/5 from its current position to 3 to 5mm further away from the calibration chart and 
perform retry.
Almost all dots are yellow•	
Move RANGE7/5 from its current position to 3 to  5mm closer to the calibration chart and perform 
retry. 

Almost all dots are red•	

Almost all dots are yellow•	

Point
If the RANGE7/5 is repositioned in position  and the problem is solved, the instrument is calibrated 
for other position ( ) as well.
If you proceed to the next step without solving the problem by performing Retry, correct calibration 
may not be possible. Be sure to solve the problem before proceeding to the next step.
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5 Scan at position . Before scanning, after positioning

Set the calibration chart to position . 
Check that the angle of the calibration chart sur-
face is like the picture in the Calibration Wizard.

If OK, click the [Scan] button.
If the chart is displaced, fine-adjust its position •	
before clicking the [Scan] button.

Check scan results on the monitor win-
dow.

Monitor window

Check scan results in the same way as with posi-
tion . 
If there are no problems, click the [Next] button.
If there is a problem, click the [Retry] button.

6 Scan at position . Before scanning, after positioning

Set the calibration chart to position . 
Check that the angle of the calibration chart sur-
face is like the picture in the Calibration Wizard.

If OK, click the [Scan] button.
If the chart is displaced, fine-adjust its position •	
before clicking the [Scan] button.

Check scan results on the monitor win-
dow.

Check scan results in the same way as with posi-
tion . 
If there are no problems, click the [Next] button.
If there is a problem, click the [Retry] button.

Monitor window
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7 Scan at position . Before scanning, after positioning

Set the calibration chart to position . 
Check that the angle of the calibration chart sur-
face is like the picture in the Calibration Wizard.

If OK, click the [Scan] button.
If the chart is displaced, fine-adjust its position •	
before clicking the [Scan] button.

Check scan results on the monitor win-
dow.

Monitor window

The bottom left monitor window shows good scan 
results. Compare them to those on the bottom 
right.
In the NG example, there are two and five colors, 
meaning the chart is tilted. If dots are missing or 
notched, the exposure is incorrect.
If there are no problems, click the [Next] button.
If there is a problem, click the [Retry] button.

8 Scan at position . Before scanning, after positioning

Set the calibration chart to position . 
Check that the angle of the calibration chart sur-
face is like the picture in the Calibration Wizard.

If OK, click the [Scan] button.
If the chart is displaced, fine-adjust its position •	
before clicking the [Scan] button.

Check scan results on the monitor win-
dow.

Check scan results in the same way as with posi-
tion . 
If there are no problems, click the [Next] button.
If there is a problem, click the [Retry] button.

Monitor window
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9 Scan at position . Before scanning, after positioning

Set the calibration chart to position . 
Check that the angle of the calibration chart sur-
face is like the picture in the Calibration Wizard.

If OK, click the [Scan] button.
If the chart is displaced, fine-adjust its position •	
before clicking the [Scan] button.

Check scan results on the monitor win-
dow.

Monitor window

The bottom left monitor window shows good scan 
results. Compare them to those on the bottom 
right.
In the NG example, the color sequence and pat-
tern steadfast differ, meaning the chart direction 
and tilt are wrong. If dots are missing or notched, 
the exposure is incorrect.
If there are no problems, click the [Next] button.
If there is a problem, click the [Retry] button.

10 Scan at position . Before scanning, after positioning

Set the calibration chart to position . 
Check that the angle of the calibration chart sur-
face is like the picture in the Calibration Wizard.

If OK, click the [Scan] button.
If the chart is displaced, fine-adjust its position •	
before clicking the [Scan] button.

Check scan results on the monitor win-
dow.

Monitor window

Check scan results in the same way as with posi-
tion . 
If there are no problems, click the [Finish] button.
If there is a problem, click the [Retry] button.



81

Startup

  

1

2

3

4

5

6

 Error 
Messages

Menu
Items

Glossary

Index

File

Edit

View

Measure

Instrument

Help 

Window
Configu-
ration

11 Data has been scanned in seven posi-
tions.
To cancel calibration halfway through, click the 
[Cancel] button. The confirmation message at 
right appears. To cancel calibration, click the [OK] 
button.

If calibration is canceled, previous calibration •	
data will continue to be used.

12 Execute calibration calculations.

Calibration calculation in progress (The estimated time 
remaining is displayed.)

These calculations use the seven sets of data to 
minimize error. Click the [Perform calculation] but-
ton.

13 Once calibration calculations have been 
completed, the residual error and result 
evaluation are displayed.
Perform the below operations according to the 
displayed result evaluation.

Displayed  
Result Evaluation Meaning Operation

Calibration ended 
successfully.

Calibration results 
are good.

Click the [Close] button to end calibration.

CAUTION Caution is need-
ed with calibra-
tion results.

Click the [Close] button to end calibration.
Be careful of the ambient temperature. To recalibrate the instrument, 
click the [Return to Beginning] button. 
If the same evaluation results after recalibration, contact Konica Mi-
nolta.

Calibration failed. There is a prob-
lem with calibra-
tion results.

Click the [Return to Beginning] button and reperform calibration.
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5.2	 Instrument information
Information on the connected instrument can be displayed as a list. The information includes the type of mod-
el, the serial number of the sensor, type of lens, date of calibration, sensor temperature and residual error.

Operating Procedure Shortcut    F7 –

1 Select [Instrument information] from the 
[Instrument] menu.
The Sensor Information dialog box appears.

2 Information on the connected sensor ap-
pears as a list.

Sensor Information Dialog Box

Connected Instrument information	 Displays information on the connected sensor.

Instrument Type	 Displays the type of the connected instrument.

Serial number	 Displays the serial number of the connected sensor. 

Firmware number	 Displays the firmware number of the connected scanning device. 

Lens type	 Displays “TELE/WIDE” as the type of lens used by the connected sensor. 

Calibration date/time	 Displays the date and time that the connected sensor was calibrated. 

Residual error	 Displays the residual error calculated during the calibration.

Temperature at calibration 	 Display the instrument temperature when calibration was performed.

Instrument temperature	 Displays the current temperature of the connected sensor. 

Warning contents	 Displays whether the connected sensor is ready for scanning or not.

		  Ready: The sensor is ready for scanning.
		  Wait: The sensor is not ready for scanning.

 Display warning message	  Displays a warning message about sensor status changing when a 
   when instrument	 checkmark is placed in the checkbox.
	 status has changed
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6.	Help
6.1	 Tool Tips
Tool tips are a function that displays a description of the operation which would be performed by a button that 
you bring the mouse cursor close to (for example a menu button or edit button).

Operating Procedure Shortcut    Ctrl+T –

1 Select [Tool tips] from the [Help] menu.

A checkmark appears next to [Tool tips] and the 
tool tips feature is activated. 
To hide the tool tips, select [Help] – [Tool tips] from 
the menu bar again. This removes the check-
mark.

Example tool tip display
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6.2	 User's Guide
This command calls pdf files of the RANGE VIEWER user's guide and reference manual (this manual).

Operating Procedure Shortcut    F1 –

1 Select [Instruction Manuals] from the 
[Help] menu.

The table of contents pages for the respective 
manuals are displayed in PDF format.

6.3	 About RANGE VIEWER
This command displays the version of the installed RANGE VIEWER as well as the version of the firmware 
used in the connected sensor. 

Operating Procedure Shortcutt    – –

1 Select [About RANGE VIEWER] from the 
[Help] menu.

The same opening window seen when the soft-
ware is started up appears.
If the instrument is not connected, “-----------”  
will be displayed in place of the firmware version. 
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Error Messages
The following error messages appear if RANGE VIEWER is incorrectly operated or trouble occurs with it. 
Take the measures as explained in “Action”.
When a message not indicated in the list is displayed, please contact our Service Department.

Error Messages Cause Action ref. page

Memory allocation error. There is not enough memory 
space for the operation.

Use a PC equipped with the recommend-
ed or higher (4 GB) memory capacity.

2
Could not export for memory was 
insufficient. 17

Export was canceled because there 
were many exports of data. 17

Available memory is low.
Save elements? 14

Instrument is still initial unstable 
status.

Little time has passed since the 
instrument was started up. The 
instrument is unstable.

Wait until the error message disappears.
6

Instrument temperature has 
changed since calibrating.

The temperature of the instru-
ment changed since the last 
time it was calibrated.

Recalibrate the instrument to ensure ac-
curacy. 6

LD safety circuit has worked. Trouble occurred in the laser 
circuit.

Shut power to the instrument OFF, wait 
at least 10 sec and turn it back ON. If the 
error message appears again, the instru-
ment may be damaged, therefore contact 
a customer service center listed in "Autho-
rized Service Facility".

–
LD safety circuit error had oc-
cured. –

LD safety circuit has been dis-
abled. –

AE failure. Exposure could not be mea-
sured because the distance to 
the work was improper.

Check the status of the work and reper-
form AE. –

AF failure. The difference between the 
set standoff distance and 
actual distance is too large.

Change the stand-off distance setting so 
that it matches the actual distance to the 
work.

42

The work is not suited for auto 
focusing.

Scan the work in the manual mode or try 
using spot AF.

43-45
68

Unable to communicate with the 
stage.

The wrong rotating stage was 
selected.

Select the correct model number. 56

Unable to finish the stage. The communication cable is 
not connected to the rotating 
stage.

Check that the communication cable is 
correctly connected. If not, connect it cor-
rectly.

–

Unable to control the stage. Power to the rotating stage is 
OFF.

Turn ON power to the rotating stage. –

Connection error Communications with the in-
strument cannot start.

Shut power to the instrument OFF, wait 
at least 10 sec and turn it back ON. If the 
error message appears again, the instru-
ment may be damaged, therefore contact 
a customer service center listed in "Autho-
rized Service Facility".

–

Timeout error while transmitting An error occurred during com-
munications with the instru-
ment.

Shut power to the instrument OFF, wait 
at least 10 sec and turn it back ON. If the 
error message appears again, the instru-
ment may be damaged, therefore contact 
a customer service center listed in "Autho-
rized Service Facility".

–
Timeout error (while obtaining er-
ror code) –

Timeout error (while obtaining de-
vice list) –

USB API error Trouble occurred with the USB 
API.

Shut power to the instrument OFF and 
shut down the RANGE VIEWER applica-
tion. Then, turn power to the instrument 
back ON and start up RANGE VIEWER.

–
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Error Messages Cause Action ref. page

I/O error An I/O error occurred. Shut power to the instrument OFF, wait 
at least 10 sec and turn it back ON. If the 
error message appears again, the instru-
ment may be damaged, therefore contact 
a customer service center listed in "Ser-
vice Support".

–

USB instrument not connected Communications with an active 
instrument were interrupted. –

Communication error An error occurred during com-
munications with the instru-
ment.

–

Lens not attached A lens is not mounted on the 
instrument or the lens is not se-
curely mounted.

Mount a lens. Choose a lens according to 
the size of the work and the distance to it. 
Mount the lens as instructed. –

AF motor error Trouble occurred with the AF 
motor.

Shut power to the instrument OFF, wait 
at least 10 sec and turn it back ON. If the 
error message appears again, the instru-
ment may be damaged, therefore contact 
a customer service center listed in "Ser-
vice Support".

–

Shutter motor error Trouble occurred with the shut-
ter motor, preventing the shut-
ter from opening and closing 
correctly.

–

Could not perform measurement.
Please check that lens cap is re-
moved and check the measure-
ment environment.

Measurement was performed 
with the lens cap attached.

Remove the lens cap.
–

The difference between the 
set standoff distance and 
actual distance is too large.

Change the stand-off distance setting so 
that it matches the actual distance to the 
work.

–

Exposure could not be mea-
sured because the distance to 
the work was improper.

Check the status of the work and reper-
form AE. 42
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Menu Items
Each window has buttons to facilitate operations in line with scanning and editing procedures. The following 
list outlines the functions of those buttons, their location in the menu bar and their shortcuts.

Menu Main Header Sub Header Shortcut Button Operation Ref.
Page

File New Ctrl+N – Creates a new file. 12

Open Ctrl+O Opens an existing file. 13

Save Ctrl+S Saves the opened file. 14

Save As – – Saves the opened file under an-
other name.

15

Export To File – – Exports elements to files. 16

To Application Ctrl+E Exports elements to other appli-
cations.

17

Preferences Shift+F1 – Accesses settings for 3D view dis-
plays, file saving processing, etc.

18

Exit – – Quits RANGE VIEWER. 21

Edit Undo Ctrl+Z Reverses the last editing opera-
tion.

22

Redo Ctrl+Y Reapplies the last undone editing 
operation.

22

Select Rectangle Shift+R Selects/unselects all points lying 
within drawn rectangles.

23

Bezier Shift+B Selects/unselects all points lying 
within drawn Bezier curves.

24

Invert Ctrl+R Inverts points between selected/
unselected.

26

Boundary Shift+E Selects only boundary points of 
elements.

27

Front facing points Shift+F Enables selecting points having the 
normal facing towards the camera.

28

Select all Elements Alt+A – Selects all elements. 29

Unselect all Elements Shift+Alt+A – Unselects all elements. 29

Select all points on 
selected elements

Ctrl+A Selects all points of selected ele-
ments.

30

Unselect all points on 
selected elements

Ctrl+Shift+A Unselects all points of selected 
elements.

30

Delete Points Ctrl+X Deletes selected points. 31

Elements – Deletes selected elements. 32

Registration Shift+Alt+R Registers selected elements. 32

Edit marker holes Shift+Alt+K Edit data near markers. 33

Merge Shift+Alt+M Merges selected elements. 34
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Menu Main Header Sub Header Shortcut Button Operation Ref.
Page

View Viewpoint Front Ctrl+1 – Displays 3D data from the front. 35

Right Ctrl+2 – Displays 3D data from the right. 35

Back Ctrl+3 – Displays 3D data from the back. 35

Left Ctrl+4 – Displays 3D data from the left. 35

Top Ctrl+5 – Displays 3D data from the top. 35

Bottom Ctrl+6 – Displays 3D data from the bot-
tom.

35

Rotate/Zoom Rotate F9 Viewpoint can be rotated, moved 
and zoomed in/out.

36

Pan F10 Moves the viewpoint. 37

Zoom F11 Zooms the view in/out. 37

Area zoom F12 Zooms the square target area in/
out.

37

Fit to window Ctrl+F Zooms the image so all elements 
fit into view.

37

Display mode Points Ctrl+Space Displays images as set of points. 38

Shades Ctrl+Space Displays shaded images. 38

Element  
Information

Alt+I – Displays settings for scanned (ele-
ment) data. Enables setting as well.

39

Measure Monitor F2 Monitors works. 41

AE/AF F3 Executes AE/AF. 43

Preview F4 Scans works at high speed for es-
timating scan results.

48

Scan F5 Scans works. 50

Scan settings F6 Sets up scanning. 67

Instru-
ment

Calibration F8 – Calibrates the sensor to improve 
scanning accuracy.

72

Instrument
information

F7 – Displays information on the con-
nected sensor.

82

Help Tool tips Ctrl+T – Shows/Hides tool tips over buttons. 83

Instruction Manuals F1 – Opens pdfs of the user's guide 
and reference manual.

84

About  
RANGE VIEWER

– – Displays the version of RANGE 
VIEWER.

84

Shortcut List (items not in the menu bar) Ref.
Page

Monitor screen

 Monochrome image display button Shift+M 9, 49

 Contours display button Shift+C

 Color bar display check button Shift+V

 (Current scanning element) Delete Shift+Del
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Glossary
rvm format Multiple elements are grouped into a single file.

rgv format Each element has its own file.

STL Files This file format is specifically for SLA CAD software by 3D Systems. 
It is supported by a wide range of analysis software and allows 3D data to be directly input 
in STL format for use with prototyping machines. The recorded 3D modeling data forms a 
polygon of the surface normal vectors and coordinates for three vertexes of a triangle. STL 
files can be ASCII or binary format, but RANGE VIEWER exports only the binary format.
Merged data is exported to a single STL file without connections between the merged ele-
ments.

ASC Files Exported ASC (ASCII) files contain 3D point data without normal information.

rmk Files Reference marker information is processed in this format.

txt Files Files in the ordinary text format. RANGE VIEWER can read in the X coordinate value, Y co-
ordinate value and Z coordinate value of the marker in each line. The X, Y and Z coordinate 
values are separated by commas or tabs.

IPC Export IPC (Inter Process Communication) uses available internal memory space to transfer data 
scanned by RANGE VIEWER to other software at high speed. 
Compared to normal file transfers, transmission is easier and faster because it does not 
require operations to save or read files.

3D Orthogonal Coordinates The position of a point in a 3D space is represented by coordinates in a 3D orthogonal coordi-
nate system. The coordinate system here uses a point near to the center of the RANGE7/5’s 
receiver lens. The Z direction extends from directly behind the light receptor along the optical 
axis to the front, the Y direction is above the receiver and the X direction is to the right.
* In the output 3D data, specific offsets are applied respectively along the XYZ axes. 

Viewpoint RANGE VIEWER lets you view elements from the front, back, top, bottom, right or left, or in 
most any orthogonal projection.
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FOV Indicator A FOV (field of view) indicator projects the below pattern of light on the work to make it easier 
to identify the scan area. 
The FOV indicator is synchronized with motor operation to continuously project the light. 
(Note: FOV indicator updates slow while RANGE VIEWER windows are being operated.)

Multi focus In the Multi focus mode, scanning is performed twice by changing the focal point.
When the Multi focus mode is active, the data of the area closer to the focal point is selected 
for calculation. Depending on the work, the effects may differ. However, when you want to 
obtain results with less data noise, set Multi focus to "Enable". Compared to when Multi focus 
is set to "Disable", it takes more time to display the results.                                                          

                                                Z                                                         Z
Scan area                                        First  

Second
 

Multi focus disabled                           Multi focus enabled
Multi focus image 

Multi focus is enabled and disabled from the Scan settings dialog box. 

AE (Auto Exposure)  
and AF (Auto Focus)

AE (Auto Exposure) is a mechanism for automatically setting image exposure conditions.
AF (Auto Focus) is a mechanism for automatically setting the focal distance to the work. 

Polygon Polygons refer to areas (surfaces) enclosed by lines (edges) connecting vertices. 

Element “Element” is the 3D data unit used by RANGE VIEWER.
Normally, one element is generated and edited from scanning.
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The estimated scan area is irradi-
ated in synch with motor opera-
tion.



3D Orthogonal Coordinates…………………… 35, 90
3D view… …………………………………………… 11
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About RANGE VIEWER… ………………………… 84
AE… ………………………………………………… 91
AE/AF…………………………………………… 43, 68
AE/AF buttons… ………………………………………9
AF… ………………………………………………… 91
All elements… ……………………………………… 29
ASC files… …………………………………… 16, 90

B
Bezier………………………………………………… 24
Bezier curves………………………………………… 25
Bezier select button………………………………… 11
Boundary… ………………………………………… 27

C
Calibration…………………………………………… 72
Calibration chart… …………………………… 57, 72
Calibration sheet… ………………………………… 72
Calibration stand… ………………………………… 72
Color bar… ……………………………………………9

D
Dark surface mode… ………………………… 46, 47
Data subsampling rate……………………………… 69
Delete………………………………………………… 31
Delete last data button…………………………………9
Deleting selected elements………………………… 31
Deleting selected points… ………………………… 31
Display mode………………………………………… 38

E
Editing tool buttons… ……………………………… 11
Edit tab… ………………………………………… 8, 10
Element…………………………………………… 7, 91
Element boundary point select button… ………11, 27
Element delete button… …………………………… 11
Element Information………………………………… 39
Element list… …………………………………… 8, 10
Element merge button……………………………… 11
Element registration button………………………… 11
Exit………………………………………………… 7, 21
Export button………………………………………… 11
Exposure level setting……………………………… 45

Index
F
Firmware version… ………………………………… 84
Fit to window button……………………………… 8, 37
FOV Indicator… ……………………………… 42, 91
Front facing points button… ……………………11, 28
Full auto scanning…………………………………… 61

H
Help………………………………………………… 83

I
Instrument…………………………………………… 72
Instrument information……………………………… 82
Invert… ……………………………………………… 26
IPC export……………………………………… 17, 90

M
Manual focusing… ………………………………… 45
Marker… …………………………………………… 65
Marker registration… ……………………………… 71
Marker size… ……………………………………… 71
Mean error…………………………………………… 32
Measure………………………………………… 41, 50
Menu bar… ……………………………………… 8, 10
Menu buttons……………………………………… 8, 10
Merge………………………………………………… 34
Monitor… …………………………………………… 41
Monitor button… ………………………………………9
Monitor window…………………………………………9
Move viewpoint button…………………………………8
Multi focus……………………………………… 42, 91

N
Navigation message……………………………… 8, 10
New…………………………………………………… 12

O
Open… ……………………………………………… 13
Open button… ……………………………………… 11

P
Paired points………………………………… 50, 51, 69
Point delete button… ……………………………… 11
Point selection invert button… …………………11, 26
Polygon… …………………………………………… 91
Registration with marker information……………… 32
Preferences… ……………………………………… 18
Preview… …………………………………………… 48
Preview button… ………………………………………9
Preview current scan window…………………………9
Previous window… ……………………………………9
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R
Rectangle… ………………………………………… 23
Rectangle select button… ………………………… 11
Redo… ……………………………………………… 22
Redo button… ……………………………………… 11
Registration… ……………………………………… 32
Residual error… ……………………………… 81, 82
rgv… …………………………………………… 13, 14
rgv format… …………………………………… 12, 90
Rotate/ Zoom………………………………………… 36
Rotating stage… ……………………………… 50, 56
Rotating stage registration… ……………………… 70
rvm…………………………………………… 12, 13, 14
rvm format…………………………………………… 90

S
Save… ……………………………………………… 14
Save as… …………………………………………… 15
Save button… ……………………………………… 11
Saving reference markers… ……………………… 66
Scan button… …………………………………………9
Scan position adjustment…………………………… 42
Scan settings……………………………………… 9, 67
Scan tab…………………………………………… 8, 10
Select………………………………………………… 23
Select all elements… ……………………………… 29
Select all points on selected elements… ………… 30
Sensor icon… …………………………………………6
Set registration points button… ………………………9
SHOT-202……………………………………… 56, 70
SHOT-602……………………………………… 56, 70
Show color bar button…………………………………9
Show contours button… ………………………………9
Show monochrome view button………………………9
Show points button… …………………………… 8, 38
Show shaded points button……………………… 8, 38
Spot AF… ……………………………………… 44, 68
Spot AF button… ………………………………………9
Stage calibrate… …………………………………… 58
Standard deviation… ……………………………… 32
Start up… ………………………………………………6
Status bar… …………………………………… 6, 8, 10
STL Files… …………………………………… 16, 90

T
Title bar… ………………………………………… 8, 10
To application………………………………………… 17
To file… ……………………………………………… 16
Tool tips……………………………………………… 83
TXT…………………………………………………… 66

U
Undo… ……………………………………………… 22
Undo button… ……………………………………… 11
Unselect all elements… …………………………… 29
Unselect all points on selected elements… ……… 30
Users Guide… ……………………………………… 84

V
View… ……………………………………………… 35
Viewpoint… …………………………………… 35, 90
Viewpoint move button……………………… 8, 10, 37
Viewpoint rotate button… ………………………… 36

Z
Zoom button… ……………………………… 8, 10, 37
Zoom selected area button………………… 8, 10, 37
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